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Apresentacdo

Este mddulo pretende colocar em pratica aprendizagens dos modulos anteriores,
conjugando os saberes adquiridos em desenho vetorial, edicdo de imagem e paginacao,
recorrendo para isso a um projeto congregador de saberes.

O docente deverda acompanhar a aprendizagem que devera partir sob forma de proposta
de trabalho a realizar. Esta proposta podera estar articulada com um projeto da disciplina

de Design Gréfico.

Objetivos da aprendizagem

Utilizar os conhecimentos sobre as diversas ferramentas da Edi¢ao Eletrdnica;
Manipular documentos e adequa-los aos fins de edi¢do pretendidos;
Executar maquetas e protdtipos;

Elaborar artes finais;

Preparar materiais para diversos tipos de impressao.

Ambito dos conteldos

Organizacao de documentos

Manipulacdo e adequacao da resolugdo de documentos

Tratamento da informacdo: Textos, graficos, fotografias, diagramas
Processamento de texto

Modos de gravagdao ou exportacdo consoante a saida final

Importacdo e exportacdo de conteudos: Textos, graficos, fotografias, diagramas
Montagem dos conteudos

Provas e revisdo grafica

Maquetizacao

Arte finalizacdo: Cortantes, manchas, bloco de texto

Preparagao para impressao
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Projeto grafico

graf
E o plano inicial que definird as caracteristicas visuais de um peca de design gréfico.
Projeto grafico é um conjunto de elementos que formam e dao caracteristicas a um meio
de informacao.
No jornal impresso, o projeto grafico define principalmente o formato do papel, a familias
tipograficas usadas e a malha tipografica (o grid).
Um bom projeto grafico editorial é aquele que conduz os olhos dos leitores sem se
tornar o elemento principal daquela pdagina. Sem interferir na qualidade da leitura. As
imagens, o tamanho das fontes tipograficas, a posicao de titulos, reticulas, boxes, fios,
enfim, todos os elementos visuais devem ser adequadamente pensados e posicionados
com o objetivo de atender a uma necessidade editorial.
Um projeto grafico é constituido de uma série de plataformas que formam a sua ldgica
construtiva. Estas estruturas definem o seu aspeto de visual - layout - (cores, tipografia,
design, etc.), bem como seu aspeto editorial (textos, linguagem, conteddo). Geralmente
um projeto grafico é antecedido de uma série de perguntas junto ao cliente, o que
se denomina briefing. O objetivo do briefing é enfatizar questdes que servirdo de
ferramentas relevantes na constitui¢cdo do projeto. Para desenvolvimento de um projeto
grafico, sdo necessarios aproximadamente de sete a dez dias antes da etapa seguinte,
gue é chamada “Reunido de pauta”, evento em que se relinem os Designers e as equipes
de Marketing, Publicidade e Edicao.
A finalidade é justamente determinar qual o formato que o projeto grafico terd e de
qgue forma ele sera representado nos média. Leva-se em torno de dez dias de producao
editorial antes da publicacdo propriamente dita do projeto grafico. Nesta etapa sdo
realizados uma série de procedimentos que revisam a propria estrutura do projeto.
Na préxima etapa é realizada a diagramacao, evento que une os aspetos visuais de um
projeto com os aspetos grafico editoriais. Leva-se em torno de sete dias para tal. Feito a
diagramacdo é enviado ao cliente um layout para ser aprovado. Com a aprovacao é feita
a revisdo ortografica e enviada a grafica o material, que retornard com uma prova que
antecede a publicacdo. Até entdo leva-se aproximadamente 10 dias em média. Validadas

as provas editoriais, da-se inicio a publicacdo do material, evento que ja antecipadamente

é fonte de reunido entre as equipes de publicidade e propaganda.
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Caracteristicas das extensoes PDF, TIFF
e JPEG

Para entender qual o melhor formato a ser usado para o fecho de um arquivo é necessario
antes compreender a diferenca entre imagens vetoriais e imagens de mapa de bits.
No primeiro grupo estdo graficos de desenhos realizados a traco (chapados, sélidos,
ilustragdes, marcas, logétipos). O segundo grupo corresponde a imagens fotograficas.
Imagens vetoriais, como o préprio nome ja diz, sdo definidas matematicamente por
vetores — sdo, na verdade, graficos com caracteristicas geométricas. Sdo consideradas
imagens vetoriais, por exemplo, tanto um logétipo quanto um texto digitado. Imagens
vetoriais podem ser movidas e ter o seu tamanho ou cor alterados sem nenhuma perda
de qualidade. A definicdo matematica dessas imagens possibilita essas alteracdes sem
nenhuma alteracdo da resolucédo final.

Programas como lllustrator, CorelDraw e InDesign permitem trabalhar com esse tipo
de imagem e os formatos de arquivos escolhidos devem preservar essa caracteristica
de vetorizacdo. Desse modo estardo garantidas linhas nitidas e sem serrilhas,
independentemente de ampliagdes.

Asimagens de mapa de bits, por sua vez, sdo constituidas por um conjunto de pequenos
elementos, os pixels, como num mosaico. Cada pixel de uma imagem de mapa de bits

tem uma posicdo determinada e um valor de cor préprio, definidos por coordenadas
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de localizacdo e por quantificagdes numéricas. Se um logotipo ou texto digitado for
descrito como mapa de bits, ao invés de vetorialmente, haverd um numero definido
de pixels que o compde. Ao ampliarmos a imagem, esse nimero ndo serd aumentado
e a resolucdo podera ser insuficiente para o novo tamanho. Como resultado, bordas
e linhas poderdo aparecer serrilhadas. Programas como o Photoshop trabalham com
mapas de bits. Esse tipo de imagem é necessario para reproduzir gradacdes tonais
subtis, como numa fotografia, mas deve ser evitado para elementos a traco, como

textos e logdtipos.

O Adobe PDF

Criado pela Adobe Systems e aperfeicoado durante os Ultimos 17 anos, o formato Portable
Document Format (PDF) é o padrdo global para a captura e a revisdao de informacao
e para o compartilhamento com quase qualquer pessoa, em qualquer lugar. E um
formato de arquivo flexivel para varias plataformas e aplicativos. Com base no modelo
de criagdo de imagem PostScript, os arquivos PDF exibem e preservam, com precisao,
fontes, layouts de pagina e graficos vetoriais e de bitmap. O formato PDF é o padrao
para a distribuicdo e o intercambio seguro e confiavel de documentos eletrénicos em
todo o mundo e qualquer pessoa pode visualiza-lo e imprimi-lo com o software gratuito
Adobe Reader. E um formato muito eficiente em processos de edi¢do de impressdo. Um
determinado trabalho salvo em PDF transforma-se em um arquivo compacto e confiavel
que vocé ou seu prestador de servigos podem exibir, editar, organizar e usar para gerar
uma prova. Em seguida, no momento certo do processo de producdo, o prestador de
servicos poderd imprimir diretamente o arquivo PDF ou processa-lo usando ferramentas
de vdrias origens para tarefas de pds-processamento, como verificagdes de comprovagao,
trapping, imposicdo e separacdo de cores.

Outra possibilidade é, ao salvar um arquivo no formato PDF, optar por criar um arquivo
compativel com PDF/X (Portable Document Format Exchange), que é um subconjunto
do Adobe PDF, com a finalidade de eliminar muitas das variaveis de cor, fonte e trapping

gue causam problemas de impressao.
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O PDF/X é um padrdo ISO e apresenta as seguintes opgoes:
PDF/X-1a:2001 e PDF/X-1a:2003 (para processos de produ¢do CMYK).
PDF/X-3:2002 e PDF/X-3:2003 (para processos de producdo com gestdo de cores).

PDF/x-4:2008 (que é confidvel para transparéncias em tempo real e gestdo de cores).

O formato TIFF

O formato Tagged-Image File Format (TIFF) é utilizado para a troca de arquivos entre
aplicativos e plataformas de computadores. E um formato flexivel de imagens bitmap
suportado praticamente por todos os aplicativos de pintura, edigao de imagens e layout
de pagina. Além disso, quase todos os scanners de mesa podem produzir imagens TIFF.
O formato TIFF suporta imagens CMYK, RGB, Lab, de cores indexadas e em tons de cinza
com canais alfa, bem como imagens no modo bitmap sem canais alfa. O Photoshop pode
salvar camadas em um arquivo TIFF. Entretanto, se o abrir noutro aplicativo, somente a

imagem achatada estara visivel.

O formato JPEG

O JPEG (Joint Photographic Experts Group) é usado frequentemente para exibir
fotografias e outras imagens de tons continuos em documentos HTML na web e noutros
servigos online. O formato JPEG oferece suporte a modos de cores CMYK, RGB e tons de
cinza, mas ndo oferece suporte a transparéncia. O JPEG preserva todas as informacdes
de cores de uma imagem RGB, porém faz a compactacdo de arquivos descartando dados
de maneira seletiva. Também é possivel salvar uma imagem com um ou mais arquivos
JPEG usando o comando “salvar” para a web e dispositivos. O JPEG oferece suporte
somente a imagens de oito bits. Se salvar uma imagem de 16 bits nesse formato, o
Photoshop automaticamente diminui a profundidade de bits.

Os arquivos podem ter diferentes niveis de compressdao. Quanto maior a compressao,
menor serd o tamanho do arquivo, porém pior serd sua qualidade. O algoritmo de
compressdo do JPEG é baseado nas limitagdes de visualizacdo do olho humano. Assim,
todas as informag¢Ges que ndo podem ser vistas serdo descartadas. No entanto, é
necessario tomar cuidado com os diferentes niveis de compactacao do arquivo. Quanto

maior a compactacdo, menor sera a qualidade da imagem. Uma vez compactado, as
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perdas no processo de gravagao sao definitivas. Da mesma forma, sucessivos comandos
de gravacgdo causam sucessivas perdas. Os niveis de compressdo vao de 0 a 12, podendo
ser digitados ou selecionados através da barra de rolagem constante na caixa de texto
“qualidade do JPEG”. Assim, se for disponibilizar imagens na internet, é interessante
manté-las em um tamanho pequeno. No entanto, se a imagem for utilizada em um

documento, muitas vezes é melhor manté-la com o maximo de qualidade possivel, para

gue a impressao nao seja prejudicada.
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O briefing

A entrevista exploratdria tem por objetivo esclarecer, desenvolver e modificar conceitos
para a formulacdo de abordagens posteriores. E a base sobre a qual se desenvolve o
pensamento futuro.

A palavra ‘briefing” é uma expressao da lingua inglesa que significa instrugdes, guia;
acao de instruir. Na publicidade, onde é aplicado usualmente, o briefing é coletado pelo
atendimento da agéncia e é utilizado para orientar o desenvolvimento das estratégias de
comunicac¢ao do cliente.

O Briefing é um documento que contém todas as informacgdes e orientacdes necessarias
para desenvolver eficazmente uma estratégia de marketing, campanha de comunicacao
ou uma simples acdo de comunicacdo. Devera ser fornecida a agéncia uma estratégia
perfeitamente clara. O briefing vai estabelecer as orientacGes gerais da campanha
que resultam da reflexdo entre anunciante e agéncia. Devem ficar definidos os alvos,
objetivos e possiveis limitagGes.

No nosso caso, sera o ponto de referéncia para o desenvolvimento de todas as outras
etapas do Projeto Aplicativo.

Ressalvadas as caracteristicas e realidades individuais, todos os briefings devem conter
informacdes sobre a empresa/cliente do projeto aplicativo em cinco dimensdes:

1. IDENTIFICACAO.

2. MERCADOLOGICA

3. ESTRATEGICA

4. CLIENTE

5. VISAO GERAL DO EMPRESARIO

Identificacdo

Dados bdsicos para conhecimento da empresa:
e Nome
¢ Data de Fundacao

e Ramo de atividade
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Sede - localizagao

Composicao acionaria

Porte (pelo numero de funciondrios ou faturacdo)
Numero de lojas/filiais - localizacdo

NuUmero de funcionarios

Caso seja enfocado no projeto uma filial, fazer também a descricao especifica adequada.

Mercadologica

Descricdo das caracteristicas do mercado aonde atua a empresa.

Descricdo do segmento

Nivel de concorréncia

Principais concorrentes

Andlise da situacdo geral do mercado (nivel de demanda, influéncias
econdmicas, sociais, politicas ou legislativas)

Conceito e posicionamento no mercado

Caracteristicas do produto/servico que oferece

Sazonalidades do mercado

Estratégica

Descricdo dos objetivos estratégicos da empresa.

Ampliacdo, diversificagdo, manutencao (Porter)

Fator chave de sucesso (qualidade de atendimento, variedade de produtos,
ponto comercial, design da loja)

Politica de treino e perfil da equipe de vendas (ou que se relaciona diretamente/

guotidianamente com o cliente).

Clientes

Descrever a politica da empresa em relacdo ao cliente. Descrever o perfil do cliente.

Levantar hipdteses sobre a satisfacdo do cliente.

h
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Perfil socioeconémico do cliente.

e Perfil comportamental do cliente (motivacbes para compra, razoes de
satisfacdo, comportamentos na hora da compra, processo de decisdo, pontos
de valoriza¢do no processo de compra).

e Politica da empresa em rela¢do ao atendimento ao cliente.

e Volume, frequéncia de compra — em processo de alteracdo ou mantido.

e Politica e agbes de comunicacdo com o cliente (mala direta, publicidade,
promocao dirigida).

e |dentificar possibilidades de insatisfacao do cliente.

e Existéncia ou ndo de banco de informagdes sobre cliente (cadastro atualizado

e seu conteudo).

-\-. |
7/

Visdo geral do empresario

Acrescentar uma andlise geral do empresario sobre o relacionamento com o cliente e o
andamento do negdcio em geral.
Observagoes gerais:
e Sempre lembrar que o momento do briefing deve ser, preferencialmente,
Unico. Evitar encontros repetitivos com o empresdrio.
e Procurar identificar se existe na empresa um processo de coleta, tratamento e

geréncia das informacdes sobre o cliente (cadastro atualizado, banco de dados
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de compras do cliente) de forma automatizada.

e Lembrar que é a partir desta coleta de informacdes que sera desenvolvido todo
o processo de problematizacdo do Projeto Aplicativo e consequentemente o
seu prosseguimento.

e Um briefing bem feito é fundamental para o bom andamento do projeto,
evitando interpretacdes erradas de informacdes, garantindo foco, objetividade
e aplicabilidade imediata aos resultados alcangados.

e As especificidades do briefing devem ser alinhadas com o professor orientador
antes de ser realizado. Ha diferencas quando o publico a ser pesquisado é
interno ou externo a empresa.

e A existéncia de um modelo ou orientacdo de briefing ndo pressupde igualdade
de tratamento para empresas de realidades e culturas diferentes. Adaptagdes e
adequacgdes deverao ser realizadas para melhor atendimento as necessidades
do Projeto Aplicativo. Os professores estdao preparados para orientar a equipe

de alunos sobre este tema.

Briefing publicitdario (um modelo)

Introducao:

Qual o conceito do produto; qual o posicionamento e quais os alvos.

Antecedentes:

Histdrico da marca; outras acdes de comunicacao.

Mercado (evolucdo, segmentacao, posicionamento de produto; investimento).
Objetivos (market share; distribuicdo; vendas; comunicacdo).

Produto (nome; caracteristicas; embalagem; preco; concorréncia).

Acao:

AcOes de comunicacdo publicitaria ou ndo; orientacdo da agéncia; budget; timming.

Contexto do Produto ou Servico.

Descricdo do produto; histérico da comunicacdo anterior da marca; descricio da

3

CURSO TECNICO DE ARTES GRAFICAS | 19

'\f”wé ; S
b g b S5



EDICAO ELETRONICA

concorréncia; analise de mercado; comportamento e atitudes dos consumidores e

influenciadores.

Estratégia de Marketing.

Objetivos de marketing (volume de vendas e quota de mercado); posicionamento,
segmentos alvos e fontes de mercado; mix de comunicagao.

Plano do produto;

Produto e concorréncia (marca produto; embalagem, preco e distribui¢cdo; consumo)
Objetivos (de mercado; de comunicacgdo).

Grupo alvo, tempo, regionalizacao.

Mix de Comunicacao:
Org¢amento.
Meios, TV, Radio, Imprensa, Outdoors; Cinema; Internet; Marketing Direto; Rela¢des

Publicas; Exposicdes; Promogdes.

Perguntas facilitadoras:

Quem, A quem, O qué; Como.
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Metodologia da criacao grafica

Concegéo

Fase de definicdo de ideias, materiais e formatos a serem usados e dos detalhes que
envolvem todo trabalho.
E nesta fase que todos os PORQUES e COMOS da campanha s3o determinados. Pensa-se

antes para poupar trabalho depois.

Atendimento traz o briefing

Atendimento é a drea da agéncia que faz o contacto direto com o cliente.

Briefing é a colecdo de informagdes sobre a campanha, tais como, objetivos, publico-

alvo, etc.

Reunido com pessoal de criacdo para passar o briefing (+ producdo grafica);

Todasasdareas daagénciasdo envolvidas no projeto. Eaformade todos se comprometerem

e trabalharem em conjunto.

Definigdo da linha de criagao;

Qual serd a linha adotada? Tradicional, Jovem, Impacto?

Objetivos do projeto;

N3do importa a comunicacdo. Um objetivo tem que ser determinado:

Aumento de vendas, de lembranga do consumidor, etc.

Publico alvo;

A quem se destina a comunicacdo. O publico primario, aquele que recebera e entenderd

a informacao, o consumidor final.

Qual é a mensagem;

Normalmente, o que se quer dizer por trds do slogan é: Quero vender mais!

Como atingir o publico alvo: revista, jornal, cartaz, etc.;

Através de pesquisa, deve ser determinado o melhor meio de se atingir o publico alvo.

De que maneira a comunicagao serd passada diretamente a esse publico.

Quais os concorrentes do cliente e o que esses concorrentes tem feito;

O que o concorrente estd falando a respeito do produto dele e o quanto isso afeta a

comunicac¢ao do produto do cliente da agéncia? De que maneira a comunicagao sera feita,
g
L'
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de modo a anular os efeitos da comunica¢do do concorrente? Que tipo de comunicagao
fazer, para ficar diferente da do concorrente?

Brainstorm para elaboracdo de ideias;

O melhor meio de se determinar os rumos da campanha, a linha criativa, slogans,

imagens, ideias basicas, etc.

Rough ou layout

O rough (lé-se ‘rafe’) é um rabisco inicial das ideias das pecgas publicitarias. O layout é
uma versdo melhorada do rough. Atualmente, com a facilidade do uso de computadores
e da versatilidade dos softwares graficos, o layout chega a ter qualidade de arte final.
Experimentacdo de varios layoutes; criacdo passa para o produtor grafico os dados
pretendidos para o material (formato, cores, tipo de papel, tipos de acabamento, etc.);
Com base nestas informacdes, comeca-se a pesquisar os materiais que serao usados nas
pecas graficas.

Atendimento passa para o produtor grafico os outros dados para a producdo do material
(quantidade, prazo para a entrega do material, dados do cliente);

Com base nos dados fornecidos pela criacdo e pelo atendimento o produtor gréfico
solicita orcamento dos fornecedores (fotolito, grafica, fotos, revisores, etc.) e elabora o
orcamento completo da agéncia para apresentar ao cliente;

Oideal é que ja exista um arquivo com todos os bons fornecedores de todos nos materiais
graficos.

Com os orgcamentos e o layout na mao o atendimento faz a apresentacao da ideia ao
cliente;

E o momento que o cliente vai ter uma ideia dos custos da campanha, dos rumos que o
planeamento e a cria¢do estdo a tomar, etc.

Ideia e orcamento aprovados segue-se para a producdo do material, em caso negativo
trabalha-se em cima de outras ideias e/ou novos orgamentos, até a aprovagdo pelo
cliente.

Caso o cliente ndo aprove a ideia, volta-se ao brainstorm para novas ideias e comeca-se

novamente a preparar novos Iayoutes, or¢gamentos, etc.
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Layout grdfico

Layout grafico tem como seus componentes a area de design ou formato de pagina
e as margens, que tal como em todo o restante processo de design deve ser bem
fundamentado pelo conteldo do trabalho e pela perspetiva criativa. Como e onde vai
ser utilizado e visualizado o nosso layout, este deve ser efetuado tendo em conta varios
sobrepostos.

O tamanho e o formato podem variar entre o de bolso e de parede, duas ou trés
dimensdes. Ao desenvolver projetos de design para a web ou multimédia em que a area
esta predefinida, as proporcdes devem ser levadas em conta. Um designer no momento
de iniciar um desenvolvimento de um trabalho necessita de fazer sempre primariamente
um desenho da estrutura da pagina a elaborar, aqui devera ja conter informagdes como,
largura do topo, margens inferiores e laterais (localizadas com objetivos de manutencdo
e conducdo do olhar), o nimero de colunas de texto, imagens e sua organizacao e, se for
caso, o numero de paginas ou a numeracgao das paginas. Com estas decisdes ja tomadas,
a estrutura das pdginas pode ser individual ou com paginas mestras, para permitir a
repeticdo automatica da estrutura ja previamente estudada.

Estruturar o layout ao longo de uma série de paginas ou superficies de modo a obter uma
flexibilidade maxima sem perder a continuidade, é importante para manter a atencdo do
leitor. As proporg¢des das margens vao variar de acordo com o contexto de design, mas
como linha condutora, a margem inferior € normalmente o dobro da margem do topo e
a margem inferior duplica a largura da margem exterior.

A maior parte do trabalho de design grafico implica um nimero de tamanhos diferentes

e elementos proporcionais que devem ser coordenados numa dada area.
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Digitalizacao

Digitalizacdo é o processo pelo qual uma imagem ou sinal analdgico é transformado em
codigo digital. Isso se da através de um equipamento e software digitalizador de imagens
(ou scanner) ou de um transdutor de sinais.

A utilizacdo de dispositivos eletrénicos, como os scanners, permitem que documentos
originalmente em papel e materiais similares, filmes negativos e positivos, microfilmes
e microfichas sejam convertidos em arquivos digitais, acessiveis em computador. Com
isso, grandes volumes de informag¢do documental podem ser armazenados em ambiente
digital, o que permite serem disponibilizadas e reutilizadas, como, por exemplo, em um
sistema de gestdo Eletrénico e Documentos, conhecido como GED ou em bancos de
imagens ou audio.

A digitalizacdo também compreende a conversdo para o cédigo digital de sinais de
audio e imagens em movimento (videos), originalmente em outros formatos como as
gravacoes em discos fonograficos em vinil (sulcos) e em sinal eletromagnético analdgico
gravados em fios, fitas e discos magnéticos.

(scanner de digitaliza¢éo de opacos e transparéncias)
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Provas digitais

As provas digitais podem definir-se como «todas aquelas provas que, tendo cor ou nao,
sdo realizadas a partir de um original digital».
Esta definicdo mesmo sendo correta é demasiado ampla e ndo permite nem delimitar
as diferentes variedades das provas digitais nem mesmo as diferentes formas da sua
utilizacdo.
Por isso é importante distinguir as diferentes provas digitais e as suas areas de aplicacdo:
e Provas de posicionamento;
e Provas de desenho;
e Provas de contrato;

e Provas de imposicao.

Todas estas provas realizam uma fungdo especifica no mundo gréfico, devido a grande
flexibilidade das mesmas, tem havido uma utilizagdo incorreta das provas. E por este
motivo que vamos tentar explicar que elementos se devem encontrar numa prova para

que esta pertenga a um determinado grupo e n3o a outro.

Provas de Posicionamento

As provas de posicionamento sdo as provas que se utilizam para verificar a posi¢do dos
elementos que formam uma pagina, isto é, sdo as provas que tentam manter o equilibrio
na pagina, quer a nivel do grafismo, quer a nivel do contragrafismo.

Estas provas podem ser realizadas por impressoras de toner que ddo o aspeto geral da
ideia pretendida. Os elementos que formam essa ideia ndo sdo definidos, podendo-se

realizar varias provas até se encontrar a posi¢ao mais adequada para o objetivo desejado.

Provas de Desenho

As provas de desenho ja contém os elementos finais que se definiram nas provas de

posicionamento. Nestas provas tanto se realizam corre¢des ortograficas como de

s :
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conteudo. Estas provas sdao normalmente realizadas por impressoras a cores que lhes
d3o um certo realismo. E de notar que a cor dessa impress3o n3o serd igual aquela que
se obtera na impressao final nas artes graficas. Estas provas ndo tém nenhum elemento

gue se possa utilizar como guia de impressao e a cor que possuem varia em cada prova.

Provas de Contrato

Estas provas sdo aquelas que tém a capacidade de mostrar todos os elementos da ideia
original no final, na impressdo nas artes graficas, assim como conseguem incorporar
elementos préprios que guiam o profissional de impressao.

Com estas provas realizam-se corregdes de cor, tanto nas cores de imagens como em
cores diretas. Dadas as suas caracteristicas sdo capazes de reproduzir todas as cores de
uma imagem vezes sem conta, mostrando as mudangas efetuadas nessa imagem. Hoje
em dia, a tecnologia que se utiliza para gerar estas provas é conhecida por CIJF. As tintas
utilizadas nestas provas sao tintas liquidas, cuja gama cromatica é a base das tintas de

impressdao em artes graficas.

Provas de Imposicdo

Estas provas mostram como fica a impressao depois de colada e cortada. As provas de
imposicdo sdo realizadas com plotters que permitem imprimir sobre papel de grande
formato, substituindo os conhecidos ozalides. Estas provas permitem ver se as paginas

estdo coladas na posicao correta.

26 | CURSO TECNICO DE ARTES GRAFICAS




Manual do Aluno

Preparacao para impressao de
separacoes

Criacdo de separacoes

Parareproduzirimagens coloridas e de tonalidades continuas, as impressoras geralmente
separam a arte em quatro chapas — uma chapa para cada parte em ciano (C), magenta
(M), amarelo (Y) e preto (K) da imagem. Quando recebem a tinta da cor apropriada e
sdo impressas em registo umas com as outras, essas cores combinam-se para reproduzir
a arte original. O processo de dividir a imagem em duas ou mais cores é denominado
separacdo de cores, e os filmes dos quais as chapas sdo criadas sdo denominados
separagdes.

Composto (esquerda) e separagées (direita)

Processos de producgdo de separagoes

O Adobe InDesign CS4 suporta dois processos de producdo comuns de PostScript.
A principal diferenca é onde as separag¢des sao criadas: no computador host (o sistema
que usa o InDesign e o driver de impressora) ou no RIP (processador de imagens

rasterizadas) do dispositivo de saida. Outra alternativa é o processo de producdo de PDF.

Separacgbes baseadas no host

No processo de producdo tradicional pré-separado baseado no host, o InDesign cria
informacgOes PostScript para cada separacdo necessaria para o documento e as envia

para o dispositivo de saida.

Separacoes In-Rip

No processo de producdao baseado em RIP mais recente, uma nova geracdao de RIPs
PostScript executa separacdes de cores, trapping e até gestdo de cores no RIP, deixando o

host livre para executar outras tarefas. Essa abordagem faz com que o InDesign leve menos
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tempo para gerar o arquivo e minimiza a quantidade de dados transmitidos para qualquer

tarefa de impressao. Por exemplo, em vez de enviar informacgGes PostScript para quatro ou

mais paginas a fim de imprimir separacdes de cores baseadas no host, o InDesign as envia

para um Unico arquivo PostScript composto para processamento no RIP.

Preparar o documento para separacdes de cores

10.

11.

12.

Corrija quaisquer problemas de cores na arte.

Defina opgdes de superimposicdo.

Crie instrucdes de trapping para compensar erros de registo na impressora
tipografica.

Visualize as separag¢des de cores na tela.

Nota: As etapas de 1 a 4 sdo recomendadas, mas ndo essenciais para produzir
separagoes de cores.

Escolha ‘Arquivo’ > ‘Imprimir’, para exibir a caixa de didlogo ‘Imprimir’.

Se tiver criado uma predefinicdo de impressora com as configuracbes de
separacdo apropriadas, selecione-a no menu ‘Predefinicdo de impressao’ na
parte superior da caixa de didlogo ‘Imprimir’.

Escolha uma impressora ou arquivo PostScript no menu ‘Impressora’.

Se estiver a imprimir num arquivo PostScript, escolha a PPD referente ao
dispositivo que imprimird as separagoes.

Para exibir ou alterar opcoes de impressdo existentes, cligue num nome de
sec¢ao no lado esquerdo da caixa de didlogo ‘Imprimir’.

Antes de entregar o documento a um prestador de servicos, faca a prova das
separagodes.

Imprima ou salve as separagoes.

Saida de cores especiais

E possivel usar tintas personalizadas, denominadas cores especiais, juntamente com as

cores de escala ou no lugar delas. Por exemplo, em vez de usar as quatro cores de escala

para reproduzir a arte com texto em preto e desenhos com linhas verdes azuladas, pode

28 | CURSO TECNICO DE ARTES GRAFICAS




Manual do Aluno

usar duas cores especiais — uma cor para o preto e outra representando o tom exato do
verde. Pode usar tintas de cores especiais para criar cores que ndo sejam reproduziveis
por tintas CMYK, como cores fluorescentes e metalicas. Pode também misturar cores
especiais, ou cores especiais com cores de escala para criar tintas mistas.

E possivel colorir uma arte com cores de escala, cores especiais ou uma combinacdo de
ambas. Ao imprimir separacgdes, pode converter cores especiais nos seus equivalentes

de cor de escala para que sejam impressas nas chapas CMYK.

Impressdo de um composto

Pode imprimir uma prova composta em cores ou escala de cinza para ver as cores do
documento. Uma imagem composta pode ajuda-lo a criar e fazer a prova do seu layout
antes de imprimir separacdes finais (que sdo caras).

Quando o InDesign imprime um composto, ele imprime todas as cores utilizadas no
arquivo em uma Unica chapa, ndo importando se foram selecionadas algumas cores

individuais.
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Considere os seguintes problemas ao imprimir compostos:

Embora nenhuma prova forneca a representacdo exata da saida final, pode aumentar
bastante a precisdo por meio da calibragem de todos os dispositivos usados na criacdo de
um documento (como scanners, monitores e impressoras). Se os dispositivos estiverem
calibrados, o sistema de gestdo de cores podera ajuda-lo a obter cores previsiveis e
uniformes.

As opgoes de superimposi¢do selecionadas no documento serdo impressas corretamente
numa impressora que suporte a superimposicdo. Como a maioria das impressoras de
mesa nao suporta a superimposicdo, pode simular seus efeitos selecionando ‘Simular
superimposicao’ na se¢do ‘Saida’ da caixa de didlogo ‘Imprimir’.

Importante: A selecdo de ‘Simular superimposicdo’ convertera cores especiais em cores
de escala para impressao. Se desejar usar um arquivo para separa¢des num RIP ou para
saida final, ndo selecione esta opgao.

Ao imprimir numa impressora em preto-e-branco, o InDesign produzird uma versao
composta de escala de cinza nas paginas. Se o documento contiver cores, o InDesign
imprimira cinzas visualmente corrigidos para simular essas cores. Por exemplo, o cinza
gue simula uma tonalidade de amarelo a 20% é mais claro do que uma tonalidade de
20% de preto, pois 0 amarelo é mais claro que o preto.

Ao imprimir um livro com capitulos contendo estilos de trapping ou tintas especiais em
conflito, é possivel instruir o InDesign a sincronizar as configura¢gdes com o documento-

mestre.
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Apresentacdo

Este mddulo pretende colocar em pratica aprendizagens dos modulos anteriores,
trabalhando fundamentalmente a producdo de contelddos vetoriais para posterior
edicdo grafica.

O docente devera apresentar uma proposta de trabalho que poderd estar ligada
interdisciplinarmente com um projeto da disciplina de Design Grafico.

O projeto aqui iniciado terd seguimento nos dois mddulos seguintes, onde serdo
realizadas as operagles correspondentes as restantes areas especificas (edicdo de

imagem e paginacao).

Objetivos da aprendizagem

Utilizar as potencialidades das ferramentas de desenho vetorial;

Utilizar corretamente as ferramentas especificas;

Praticar os aspetos transversais da edicdo eletronica;

Executar corretamente a arte finalizacao;

Identificar os métodos e estilos de trabalho otimizadores do fluxo de producdo, a

semelhanca dos utilizados em meios profissionais.
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Ambito dos conteudos

Estruturacao de um projeto

Tratamento da informacgdo: Textos, graficos, diagramas, e outros
Digitalizacdo de opacos e transparéncias

Desenho e edicdo de conteudos vetoriais

Maquetizagao

Arte finalizacao
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Imagem Vetorial x Imagem Bitmap

Para compreender as diferencas entre imagens vetoriais e imagens bitmaps, vamos
transporta-lo a escola...

Lembra-se de quando estudou ciéncias na escola, e lhe foi apresentado o dtomo? Na
verdade, via um atomo, ele é de facto como foi descrito. Por outro lado, foi apresentado
um modelo, um “faz de conta” que, apesar de ndo ser o atomo de verdade, permitiu
gue compreendesse e pudesse trabalhar com dtomos. De modo analogo, explicaremos
a diferenca entre imagens vetoriais e imagens bitmap, e programas que trabalham
com imagens vetoriais e programas que trabalham com imagens bitmaps (mapas de
bits). O que vamos exemplificar ndo é a realidade absoluta (precisaria de um bocado de

matematica), mas demonstra claramente a diferenca entre os dois sistemas.

Imagem vetorial

Como na fisica, onde um vetor é uma entidade definida pelos atributos direcdo, médulo
e sentido, podemos dizer que, na comunicacdo visual, os vetores (imagens vetoriais) sdo
objetos definidos, também, pelos seus atributos.

Assim, de modo simplificado, o objeto abaixo (imagem vetorial) poderia ser definido da
seguinte maneira:

e Tipo de Curva = Circunferéncia

e Raio=1cm

e Preenchimento = amarelo

Contorno = azul

s -

R4t e

36 | CURSO TECNICO DE ARTES GRAFICAS

>

{1



Manual do Aluno

Observe que, para guardar esse circulo, ndo precisamos gravar a imagem propriamente
dita, que seriam os pixels (gastaria muita memaria).

Se guardarmos os atributos, como “Circunferéncia”, preenchida de “amarelo”, contornada
por “azul” e com raio de “1 cm”, qualquer computador poderia reproduzi-la! Esta é a

principal caracteristica de uma imagem vetorial.

Cada vez que o lllustrator (ou outro software vetorial como CorelDRAW, ou o PowerPoint,
por exemplo) for carregar uma imagem vetorial, ele lerd, do disco, os atributos e
REDESENHARA a imagem, claro, obtendo uma idéntica a original!

Ainda, pensando nessa linha, se decidissemos aumentar o raio para 3 cm, apesar de
gastarmos mais espaco de tela, ndo gastariamos mais espaco no disco. Afinal, o circulo

(os pixels que o compdem) ndo serd gravado no disco. Apenas os atributos!

e Tipo de Curva = Circunferéncia
e Raio=3cm
* Preenchimento = amarelo

e Contorno = azul

Imagem Bitmap ou Imagem Raster (Mapa de Bits)

Imagem Bitmap pixel a pixel. Uma fotografia digitalizada é um exemplo claro de imagem

bitmap. Dificilmente terd o mesmo efeito apenas com objetos vetoriais. Por isso, o

4
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CorelDRAW (e outros do género), que é um programa vetorial, aceita a importacdo
de imagens bitmaps, de modo a que possa criar trabalhos misturando os dois tipos de
imagens (bitmap e vetorial).

Claro que o CorelDRAW ndo trabalha estas imagens do mesmo modo que programas
especificos o fazem, como o Corel Photo-Paint, o Photoshop e o préprio Paint do
Windows.

Bitmaps s3ao imagens que, apresentadas no monitor, sdo divididas em pequenos
guadradinhos, cada um, com uma cor. Esses quadradinhos chamam-se pixels. Quando
se grava na modalidade bitmap, grava-se o conteuddo de cada pixel. Num programa que
manipula bitmaps, como o Paint do Windows ou o Photoshop, pode alterar a cor até
mesmo de um unico pixel!

Apesar das vantagens para se trabalhar com fotos, icones, ou outros desenhos, existem

algumas desvantagens para os arquivos do tipo bitmap.

N

Redimensionamento do bitmap

O sistema perde quando precisamos redimensionar imagens. Como os pixels ndo sdo
redimensiondveis, perdemos pixels ao reduzirmos o tamanho da imagem. De modo
oposto, ao ampliarmos uma imagem bitmap, sdo acrescentados pixels (o programa
INVENTA os pixels que sdo acrescentados). Por isso, por mais sofisticada que seja
a interpolagdao de pixels, imagens bitmaps com tamanho alterado ndao apresentam

qualidade muito boa, especialmente, quando ampliamos.

No armazenamento em disco

Imagine o quanto se consome de disco, numa circunferéncia com raio de 30 cm, se

tivéssemos que armazena-la conforme o exemplo seguinte:
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Quadrado da linha 01, coluna 01 = branco
Quadrado da linha 01, coluna 01 = branco
Quadrado da linha 18, coluna 12 = azul
Quadrado da linha 18, coluna 12 = amarelo

Quadrado da linha 18, coluna 12 = amarelo

Exemplo de ampliagéo de uma Imagem Vetorial

Observe como fica perfeita a ampliagao de uma imagem vetorial. O |apis foi construido
(e ampliado) num programa de vetores (CoreIDRAW) e ndo tem o acabamento de uma

foto.

Exemplo de ampliagéGo de uma Imagem Bitmap

Um bitmap pode conter muito mais detalhes e parecer perfeito. No entanto, ao
redimensionarmos, poderemos ter perda de qualidade. Na figura, o [dpis menor é um
bitmap obtido de um desenho vetorial (original). Ao ampliar a o ldpis num programa

bitmap, como o Paint, por exemplo, note que a qualidade do resultado vai diminuindo.
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De Vetor para Bitmap

Como Rasterizar Imagens

Imagem Vetorial Rasterizada, chamamos de rasteriza¢do ao processo de transformacao
de umaimagem vetorial em umaimagem bitmap, também conhecida como raster. Neste
caso, teremos uma imagem rasterizada.

Em geral, isto é possivel importando imagens, originalmente vetoriais, em programas
gue trabalham com imagens bitmap.

O Photoshop permite esse processo e, provavelmente, utilizara muitas vezes, como, por
exemplo, para apresentar logdtipos (usualmente concebidos como vetor) em paginas de
internet, como imagem jpg, gif ou png.

Os programas que trabalham com vetores, como o CorelDRAW, o InDesign e o lllustrator,
também costumam permitir a exportagao para bitmap.

Exemplo: a imagem em baixo é uma estilizacdo em linha produzida no lllustrator e, poste-

riormente, rasterizada, ou seja, transformada em imagem bitmap. Aqui, no formato .png.
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De Bitmap para Vetor

Como Vetorizar Imagens

Existemaplicativos,comooVector Magice o Magnigraph, quevetorizamautomaticamente
uma imagem bitmap, transformando-a em vetor por um processo conhecido como auto-
tracing. Funciona bem, em especial para elementos com contornos bem definidos.

Os Designers, no entanto, trabalham muito com o que chamamos de vetorizagdo manual.
Como que decalcando um desenho (quando coloca uma transparéncia sobre a imagem
original e desenha uma nova) e utilizando ferramentas adequadas de programas como o
Illustrator ou o CorelDRAW, obtém-se uma imagem vetorizada mais perfeita e detalhada.
Com este processo, pode tanto obter uma ilustracdo realista (onde imagem vetorizada
e imagem bitmap parecem idénticas), ou uma simplificacdo (ilustracao estilizada), como
o morango da figura.

Uma tarefa comum para designers é a vetorizacdo de logos antigos, cuja digitalizacao
produziu um bitmap. Transformando o logo antigo em vetor, temos a possibilidade
de redimensiona-lo sempre com perfeicdo, além de poder aplica-lo nos mais diversos
materiais. Claro, recomenda-se que os logos novos sejam concebidos com programas

vetoriais (ap0ds, é claro, uma série de rafes a mao).
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Vetor por Observacdo

Os Designers também costumam desenhar a partir da observacdo de um objeto real. Esse
desenho pode ser feito com lapis e papel e depois digitalizado e vetorizado (lllustrator
ou CorelDRAW) ou diretamente desenhado dentro do lllustrator ou CoreIDRAW com o
auxilio de uma Tablet (pequena mesa digitalizadora).

Exemplo: |apis desenhado no InDesign com a ferramenta Pen (sem tablet).

- =
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Sobre imagens de bitmap

Imagens de bitmap, tecnicamente chamadas de imagens de varredura, usam uma grade
retangular de elementos de figura (pixels) para representar imagens. E atribuido a cada
pixel um local especifico e um valor de cor. Ao trabalhar com imagens de bitmap, vocé
edita pixels em vez de objetos ou formas. Imagens de bitmap sdo o meio eletrénico mais
comum para imagens de tons continuos, como fotografias ou pinturas digitais, porque
podem representar gradagdes subtis de sombras e cores com mais eficiéncia.

As imagens de bitmap dependem da resolucdo, isto é, elas contém um numero fixo
de pixels. Como resultado, elas podem perder detalhes e ter uma aparéncia irregular
se forem redimensionadas numa ampliacdo alta na tela ou se forem impressas numa

resolucdao mais baixa do que aquela em que foram criadas.

Exemplo de uma imagem de bitmap em diferentes niveis de ampliagdo

As imagens de bitmap podem exigir grandes quantidades de espaco de armazenamento
e, geralmente, precisam ser compactadas para reduzir o tamanho dos arquivos em
determinados componentes do Creative Suite. Por exemplo, compacta um arquivo de

imagem no seu aplicativo original antes de importa-lo para um layout.

Diretrizes de resolucdo da imagem para saida final

As imagens de bitmap contém um numero fixo de pixels, que geralmente sdo medidos
em pixels por polegada (ppi). Uma imagem de alta resolugcdo contém mais pixels (e,

portanto, pixels menores) em comparagdo a uma imagem com as mesmas dimensdes
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impressas de baixa resolugdo. Por exemplo, uma imagem de 1 por 1 polegada com uma
resolucdo de 72 ppi contém um total de 5184 pixels (72 pixels de largura x 72 pixels de
altura = 5184). A mesma imagem de 1 por 1 polegada com uma resolucdo de 300 ppi

conteria um total de 90.000 pixels.

Em imagens de bitmap importadas, a resolucao da imagem é determinada pelo arquivo
de origem. Em efeitos de bitmap, é possivel especificar uma resolu¢do personalizada.
Para determinar a resolucdo de imagem a ser usada, considere a média de distribuicdo
final para aimagem. As seguintes instrucdes podem ajuda-lo a determinar seus requisitos

para a resolu¢dao da imagem:

Impresséo comercial

A impressdo comercial requer imagens de 150 a 300 ppi (ou mais), dependendo da
impressao (dpi) e frequéncia de tela (Ipi) que estiver a ser usada; consulte sempre o
provedor de servicos de pré-impressao antes de tomar decisdes de producdo. Uma vez
gue a impressao comercial requer imagens grandes, de alta resolucdo, que levam mais
tempo para exibir enquanto estiver a trabalhar com elas, convém usar as versdes de
baixa resolucdo para layout e, em seguida, substitui-las por versdes de alta resolucdo na
fase de impressao.

No lllustrator e InDesign, é possivel trabalhar com versdes de baixa resolu¢do usando
o painel Vinculos. No InDesign, pode escolher as opcdes Tipico ou Exibicdo Rapida no
menu Visualizar > Exibir desempenho; no Illustrator, pode escolher Visualizar > Contorno.
Como alternativa, se o seu provedor de servigos oferece suporte ao Interface de Pré-

impressdao Aberta (OPI), é possivel que ele forneca imagens de baixa resolucao.

Impresséo em desktop

As impressGes em desktop geralmente exigem imagens no intervalo de 72 ppi (para
fotografias impressas numa impressora de 300 ppi) a 150 ppi (para fotografias impressas
em dispositivos de até 1000 ppi). Em arte vetorial (imagens de 1 bit), verifique se a

resolucdo dos seus graficos corresponde a resolucao da impressora.
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Edicdo na Web

Uma vez que a edicdo on-line geralmente requer imagens com dimensdes em pixel que
se ajustam ao monitor destinado, as imagens normalmente tém menos de 500 pixels
de largura e 400 pixels de altura, para deixar espaco para os controles de janela do
navegador ou para tais elementos de layout como legendas. A criacdo de uma imagem
original na resolucdo de tela (96 ppi para imagens do Windows e 72 ppi para imagens do
Mac OS) permite que vocé veja a imagem como ela provavelmente aparecera quando
visualizada em um navegador da Web comum. Durante a edi¢do on-line, as Unicas
ocasiGes em que pode precisar de resolucdes acima desses intervalos é quando desejar
gue os utilizadores possam aplicar mais zoom para obter mais detalhes num documento

PDF, ou quando estiver a produzir um documento para impressao sob demanda.

4
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Ferramenta extrusao interativa no
CorelDraw

O CorelDraw é um programa que nos permite fazer coisas incriveis e as imagens vetoriais
sdo o seu forte, pois, ao contrario de outros programas, ele permite a edicdo dessas
imagens por pontos especificos, os nds. Uma ferramenta muito interessante é a Extrusao
Interativa que permite transformar as suas imagens vetoriais numa espécie de 3D. Veja
nesse tutorial de como usar a Extrusao Interativa no CorelDraw.

Para comecar abra o CorelDraw e para fazer o teste pode simplesmente escrever uma
palavra ou usar uma das formas que o programa disponibiliza. E interessante deixar o
texto ou figura num tamanho razoavelmente grande para poder ver melhor o efeito que
a ferramenta tera.

Com a imagem selecionada deverd ir até as ferramentas que ficam posicionadas na
caixa de tools, em geral a direita. Escolha o menu mistura e nele a ferramenta Extrusao

Interativa.

Como na imagem abaixo.

g Mistura
Contorno

{0 Distorcer

J Sombreamento
{=t  Envelope

L Extrusdo l

Transparéncia

Perceba que sobre a sua imagem se formou um tipo de quadrado com um ponto no
centro. Manipulando a linha pontilhada é possivel controlar o quanto a imagem terd
a ideia de profundidade, pode deixar totalmente em 3D ou apenas com um pouco de

volume. Veja o exemplo abaixo.
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E como toda ferramenta do CorelDraw a Extrusdao também abre um menu especifico
na barra acima dessa forma existem opc¢bes especiais para complementar o uso dessa
ferramenta. Para dar mais realismo a ideia de 3D pode usar a op¢do Extrusdo Rotativa
gue estd nesse menu acima. Aparecerd um numero 3 quando selecionar essa opcao,

rode como gostaria de visualizar a rotacao da imagem. Veja na imagem abaixo.

[ a2 ¢ 26
=

E o resultado final...
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Desenho

Sobre os grdficos vetoriais

Os graficos vetoriais (as vezes chamados de formas vetoriais ou objetos vetoriais) sdo
compostos de linhas e curvas definidas por objetos matematicos chamados de vetores,
gue descrevem uma imagem de acordo com suas caracteristicas geométricas.

E possivel mover ou modificar graficos vetoriais livremente sem perda de detalhes ou
clareza, porgue eles ndo dependem da resolucdo — eles mantém arestas bem definidas
ao serem redimensionados, impressos numa impressora PostScript, salvos num arquivo
PDF ou importados para um aplicativo de imagens graficas baseado em vetores. Como
resultado, os graficos vetoriais sdo a melhor opc¢ao para arte-final, como logdtipos, que
serao usados em diversos tamanhos e em varios suportes de saida.

Os objetos vetoriais que cria ao usar as ferramentas de desenho e forma no Adobe
Creative Suite s3o0 exemplos de graficos vetoriais. E possivel usar os comandos Copiar e

Colar para duplicar graficos vetoriais entre componentes do Creative Suite.

Sobre demarcadores

A medida que se desenha, uma linha chamada demarcador é criada. Um demarcador é
composto de um ou mais segmentos retos ou curvados. O inicio e o fim de cada segmento
€ marcado por pontos de ancoragem, que funcionam como pinos mantendo um arame
no lugar. Um demarcador pode ser fechado (por exemplo, um circulo) ou aberto, com

extremidades distintas (por exemplo, uma linha ondulada).
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E possivel alterar a forma de um demarcador arrastando os pontos de ancoragem, os
pontos de direcdo no final das linhas de direcdo que aparecem em pontos de ancoragem,

ou o préprio segmento de demarcador.

Componentes de um demarcador

A. Extremidade selecionada (sélida)

B. Ponto de ancoragem selecionado

C. Ponto de ancoragem ndo selecionado
D. Segmento de demarcador curvado

E. Linha de direcao

F. Ponto de direcdo

Os demarcadores podem ter dois tipos de pontos de ancoragem: pontos de vértice e pontos
suaves. Num ponto de vértice, o demarcador muda repentinamente de direcdo. Num
ponto suave, os segmentos do demarcador s3o conectados como uma curva continua. E
possivel desenhar um demarcador usando qualquer combinagdo de pontos de vértice e

pontos suaves. Se desenhar o tipo errado de ponto, é sempre possivel altera-lo.

Pontos em um demarcador
A. Quatro pontos de vértice
B. Quatro pontos suaves

C. Combinac¢do de pontos de vértice e pontos suaves

4
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Um ponto de vértice pode conectar dois segmentos retos ou curvados, enquanto um

ponto suave conecta sempre dois segmentos curvados.

Um ponto de vértice pode conectar tanto os segmentos retos como os curvados.

O contorno de um demarcador é chamado de tracado. Uma cor ou um degradé aplicados
a uma area interior aberta ou fechada do demarcador sdo chamados de preenchimento.
Um tracado pode ter espessura, cor e um padrdo de tracgo (lllustrator e InDesign), ou um
padrdo de linha estilizado (InDesign). Apds criar um demarcador ou uma forma, pode
alterar as caracteristicas do seu tracado e preenchimento.

No InDesign, cada demarcador exibe também um ponto central, que marca o centro da
forma, mas ndo faz parte do demarcador em si. Pode usar esse ponto para arrastar o
demarcador, para alinhar o demarcador a outros elementos ou para selecionar todos os
pontos de ancoragem no demarcador. O ponto central estd sempre visivel; ele ndo pode

ser ocultado ou excluido.

Sobre linhas de direcdo e pontos de direcdo

Quando seleciona um ponto de ancoragem que conecta segmentos curvados (ou
seleciona o proprio segmento), os pontos de ancoragem dos segmentos de conexao
exibem alcas de direcdo, que consistem em linhas de direcdo que finalizam em ponto
de direcdo. O angulo e o comprimento das linhas de direcdo determinam a forma e o
tamanho dos segmentos curvados. A movimentacdo dos pontos de direcao remodela as

curvas. As linhas de direcao ndo aparecem na saida final.
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Ap0s selecionar um ponto de ancoragem (a esquerda), as linhas de dire¢cdo aparecem

em quaisquer segmentos curvados conectados pelo ponto de ancoragem (a direita).

Um ponto suave tem sempre duas linhas de direcdo, que se movem juntas como
uma unidade Unica e reta. Quando uma linha de diregao é movida num ponto suave,
os segmentos curvados de ambos os lados do ponto se ajustam simultaneamente,
mantendo uma curva continua naquele ponto de ancoragem.

Em comparacdo, um ponto de vértice pode ter duas, uma ou nenhuma linha de direcao,
dependendo se ela junta dois, um ou nenhum segmento curvado, respetivamente. As
linhas de direcdo do ponto de vértice mantém o vértice usando angulos diferentes. Ao
mover uma linha de direcdo num ponto de vértice, s6 é ajustada a curva do mesmo lado

do ponto que a linha de diregao.

Ajuste de linhas de direcdo num ponto suave (a esquerda) e em ponto de vértice

(a direita)
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As linhas de direcdo sdao sempre tangentes (perpendicular ao raio de) a curva nos pontos
de ancoragem. O angulo de cada linha de diregao determina a inclinagdo da curva, e 0

comprimento de cada linha de direcdo determina a altura, ou profundidade, da curva.

Mover e redimensionar as linhas de dire¢@o altera a inclinagdo das curvas.
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Sobre simbolos

Um simbolo é um objeto artistico que pode ser reutilizado num documento. Por exemplo,
se criar um simbolo a partir de uma flor, podera adicionar instancias desse simbolo varias
vezes ao seu trabalho artistico sem adicionar realmente a arte complexa varias vezes.
Cada instancia de simbolo é vinculada ao simbolo no painel Simbolos ou a uma biblioteca
de simbolos. O uso de simbolos pode poupar tempo e reduzir significativamente o
tamanho do arquivo.

Os simbolos também fornecem um excelente suporte para exportagdao SWF e SVG. Ao
exportar para o Flash, pode definir o tipo de simbolo como Clipe de filme. Ao aceder
ao Flash, sera possivel escolher tipo, se necessario. Também pode especificar a escala
de 9 fatias no lllustrator, para que os simbolos sejam dimensionados apropriadamente

guando usados para componentes da interface do usuario.

YELLOWSTONE
+IN LAKE
. Grant Village
Amphitheater
/ Visitor Center

[
&

~ Post Office
7~ Lodge Registration

Trabalho artistico com instdncias de simbolo
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Inserir um simbolo

Selecione um simbolo no painel Simbolos ou numa biblioteca de simbolos.

Siga um destes procedimentos:

Clique no botdo Place Symbol Instance no Painel Simbolos para inserir a instancia no
centro da darea visivel atual da janela do documento.

Arraste o simbolo até a prancheta, no local em que deseja exibi-lo.

Selecione Inserir instancia de simbolo, no menu do painel Simbolos.

Nota: Um unico simbolo inserido em qualquer local do trabalho artistico (ao contrdrio de

existir apenas no painel) é chamado de uma instdncia.

Criar um simbolo

Selecione o trabalho artistico a ser usado como simbolo.

Siga um destes procedimentos:

Clique no botdo Novo simbolo , no painel Simbolos.

Arraste o trabalho artistico até o painel Simbolos.

Selecione Novo simbolo, no menu do painel.

Nota: Por padrdo, o trabalho artistico selecionado torna-se uma instdncia do novo
simbolo. Se ndo quiser que o trabalho artistico se torne uma instdncia, pressione Shift ao
criar o novo simbolo. Além disso, se nGo quiser que a caixa de didlogo Novo simbolo seja
aberta quando um novo simbolo for criado, pressione a tecla Alt (Windows), ou Option
(Mac 0S), enquanto cria o simbolo, e o lllustrator usard um nome padrdo para ele, como

Novo simbolo 1.

Na caixa de didlogo Op¢des de simbolo, digite um nome para o simbolo.

Selecione o tipo de simbolo como Clipe de filme ou Grafico. Se planeia exportar os
simbolos para o Flash, faca o seguinte:

Selecione Clipe de filme para o tipo. Clipe de filme é o tipo de simbolo padrdao no Flash
e no lllustrator.

Na grade de Registo, especifique um local desejado para definir o ponto ancora do

simbolo. O local do ponto ancora afeta a posi¢cao do simbolo nas coordenadas da tela.
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Selecione Ativar guias para escala de 9 fatias, se quiser utilizar a escala de 9 fatias no
Flash.

Selecione a opc¢ao Alinhar a grade de pixels para aplicar ao simbolo a propriedade de
alinhamento de pixels. Para obter mais informacgdes, consulte Alinhamento de simbolos
a grade de pixels.

Pode criar simbolos a partir da maioria dos objetos do Illustrator, incluindo caminhos,
caminhos compostos, objetos de texto, imagens rasterizadas, objetos de malha e grupos
de objetos. Entretanto, ndo pode criar um simbolo a partir de uma arte vinculada ou de

alguns grupos, como grupos de graficos.
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Selecao de cores

E possivel selecionar cores para um trabalho artistico a partir de vdrias ferramentas, painéis
e caixas de didlogo no lllustrator. A forma de sele¢do das cores depende das necessidades
do trabalho artistico em questdo. Por exemplo, se deseja usar cores especificas aprovadas
pela sua empresa, convém selecionar cores na biblioteca de amostras aprovada pela
empresa. Se deseja corresponder as suas cores com as cores noutro trabalho artistico, use
o conta-gotas ou o Seletor de cores e insira valores de cor exatos.

E possivel usar qualquer um dos recursos a seguir para selecionar cores:

Painel Amostras e painéis de bibliotecas de amostras

Fornecem cores individuais e grupos de cores. Pode escolher entre amostras e bibliotecas
existentes ou criar as suas préprias versoes desses itens. Também é possivel importar

bibliotecas.

Seletor de cores

Fornece um espectro de cores a partir do qual é possivel fazer a selecao visual de cores,
além de conter caixas de texto de valores de cor para a definicido manual de cores e

amostras de cores.

Ferramenta Conta-gotas

Obtém amostras de cores a partir de um trabalho artistico quando clica nele.

Painel Cor

Fornece um espectro de cores, seletores de cor individuais (como um seletor de Ciano) e
caixas de texto de valores de cor. E possivel especificar cores de preenchimento e tracado
no painel Cor. No menu do painel Cor, pode criar cores inversas e complementares para
a cor de preenchimento ou tracado atual, além de criar uma amostra a partir da cor

selecionada.
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Painel Guia de cores

Fornece vdrias regras de harmonia que podem ser escolhidas para a criacdo de grupos
de cores, usando uma cor base selecionada por si. E possivel criar variacdes de cores
usando tons e graduacdes de co, cores quentes ou frias ou cores vivas e brandas. Nesse

painel, pode abrir um grupo de cores na caixa de didlogo Editar cores/Recolorir arte.

Caixa de didlogo Editar cores/Recolorir arte

Parte dessa caixa de didlogo fornece ferramentas para definir ou ajustar com precisado as
cores em um grupo de cores ou num trabalho artistico. A outra parte permite recolorir
o trabalho artistico com as cores de um grupo de cores ou reduzir ou converter as suas

cores para saida.

Comando Adicionar cores selecionadas ou botdo Novo
grupo de cores

Crie um grupo de cores contendo as cores no trabalho artistico selecionado. Esse

comando e esse botdo estdo ambos localizados no painel Amostras.

Visdo geral do Seletor de cores

Com o Seletor de cores,

pode selecionar a cor
de preenchimento ou
tracado de um objecto,
escolhendo um espec-
tro e um campo de cor,
definindo cores nume-
ricamente ou clicando

em uma amostra.
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A. Campo de cor

B. Valores de cor HSB

C. Novo retdngulo de cor

D. Retdngulo de cor original
E. Seletor de cor

F. Espectro de cores

G. Valores de cor RGB

H. Valor de cor hexadecimal

1. Valores de cor CMYK

Visdo geral do painel Cor

Use o painel Cor (Janela > Cor) para aplicar cor ao preenchimento e ao tragado de um
objeto e também para editar e misturar cores. O painel Cor pode exibir valores de cor
usando diferentes modelos de cores. Por padrdo, apenas as op¢des utilizadas com mais

frequéncia sdo visiveis no painel Cor.

Ocultar opgies

Escala de tons de cinza
RGEB

H58

CMYE

RGE WebSafe

Inverter

Complementar

(] E F G Criar nova amostra...

A. Cor de preenchimento

B. Cor do trag¢ado

C. Menu do painel

D. Caixa Nenhum

E. Barra do espectro de cores
F. Seletor de cor

G. Caixa de texto para um componente de cor
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Desenho com a ferramenta Caneta

Desenho de segmentos de linha reta com a ferramenta
Caneta

O demarcador mais simples que pode desenhar com a ferramenta Caneta é uma linha
reta, feita com a sele¢do da ferramenta Caneta para criar dois pontos de ancoragem.
Se continuar a clicar, criard um demarcador composto de segmentos de linha reta

conectados por pontos de vértice.

Clicar na ferramenta Caneta cria segmentos retos.

Selecione a ferramenta Caneta.

Posicione a ferramenta Caneta no local de inicio do segmento reto e clique para definir
o primeiro ponto de ancoragem (ndo arraste).

Cligue novamente onde deseja que o segmento termine (clique com a tecla Shift
pressionada para restringir o angulo do segmento a um multiplo de 45°).

Continue a clicar para definir pontos de ancoragem para segmentos retos adicionais.

O ultimo ponto de ancoragem a ser adicionado sempre é um quadrado sdlido, indicando
que ele esta selecionado. Os pontos de ancoragem anteriormente definidos tornam-se
vazados e desmarcados conforme mais pontos de ancoragem sdo adicionados.
Complete o demarcador executando um dos seguintes procedimentos:

Para fechar o demarcador, posicione a ferramenta Caneta sobre o primeiro ponto de an-
coragem (vazio). Um pequeno circulo aparecera junto ao ponteiro da ferramenta Caneta

quando ela estiver posicionada corretamente. Clique ou arraste para fechar o demarcador.
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Para deixar o demarcador aberto, clique em qualquer lugar longe de todos os objetos
com a tecla Ctrl (Windows) ou Command (Mac OS) pressionada.

Para deixar o demarcador aberto, vocé também pode selecionar uma ferramenta
diferente ou escolher Selecionar > Cancelar sele¢dao no lllustrator, ou Editar > Cancelar
todas as sele¢Ges no InDesign. No InDesign ou no lllustrator, vocé também pode

pressionar Enter ou Return para sair de um caminho aberto.

Desenho de curvas com a ferramenta Caneta

Crie uma curva adicionando um ponto de ancoragem onde uma curva muda de direcdo
e arrastando as linhas de direcdo que formam a curva. O comprimento e a inclinacdo das
linhas de direcao determinam a forma da curva.

As curvas sdo mais faceis de serem editadas e seu sistema pode exibi-las e imprimi-las
mais rapido se elas forem desenhadas usando o menor nimero de pontos de ancoragem
possivel. O uso de muitos pontos também pode gerar saliéncias indesejadas numa curva.
Em vez disso, desenhe pontos de ancoragem bem espacados e pratique a formatacdo

das curvas ajustando o comprimento e os angulos das linhas de direcao.

Selecione a ferramenta Caneta.

Posicione a ferramenta Caneta no local de inicio da curva e mantenha o botdo do rato
pressionado.

O primeiro ponto de ancoragem aparece e o ponteiro da ferramenta Caneta muda para
uma seta. (No Photoshop, o ponteiro muda apenas depois que tiver comecado a arrastar.)
Arraste para definir a inclinagdo do segmento curvado que estiver a criar e, em seguida,
solte o botdo do rato.

Em geral, estenda a linha de direcdao a um terco da distancia do préximo ponto de
ancoragem que planeia desenhar. (E possivel ajustar posteriormente um dos lados da
linha de direcdo ou ambos.)

Pressione a tecla Shift para restringir a ferramenta a multiplos de 45°.
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Desenho do primeiro ponto numa curva
A. Posicionamento da ferramenta Caneta
B. Comegando a arrastar (botdo do rato pressionado)

C. Arrastando para estender as linhas de dire¢do

Posicione a ferramenta Caneta no local em que deseja que o segmento curvado termine
e execute um dos procedimentos a seguir:
Para criar uma curva em forma de C, arraste em uma direcdo oposta a linha de direcao

anterior. Em seguida, solte o botdo do rato.

Desenho do sequndo ponto numa curva

A. Comegando a arrastar o segundo ponto suave
B. Arrastando longe da linha de dire¢do anterior, criando uma curva C

C. Resultado apds soltar o botdo do rato
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Para criar uma curva em forma de S, arraste na mesma direcdo da linha de direcao

anterior. Em seguida, solte o botdo do rato.

Desenho de uma curva S

A. Comegando a arrastar o novo ponto suave
B. Arrastando na mesma direcéo da linha de dire¢do anterior, criando uma curva S

C. Resultado apds soltar o botdo do rato

Desenho de linhas retas sequidas de curvas

Usando a ferramenta Caneta, clique nos pontos de vértice em dois locais para criar um
segmento reto.

Posicione a ferramenta Caneta sobre a extremidade selecionada. No lllustrator e
InDesign, um icone de conversdo de pontos aparece ao lado da ferramenta Caneta
quando ela esta posicionada corretamente (no Photoshop, uma pequena linha diagonal,
ou barra, aparece ao lado da ferramenta Caneta). Para definir a inclinacdo do segmento
curvado que sera criado a seguir, clique no ponto de ancoragem e arraste a linha de

direcao exibida.

62 | CURSO TECNICO DE ARTES GRAFICAS




Manual do Aluno

Desenho de um segmento reto seguido por um segmento curvado (parte 1)
A. Segmento reto concluido
B. Posicionando a ferramenta Caneta sobre a extremidade (o icone Converter Pontos
aparece somente no lllustrator e no InDesign)

C. Arrastando o ponto de dire¢éio

Posicione a caneta onde deseja colocar o préximo ponto de ancoragem; em seguida,

clique (e arraste, se desejado) o novo ponto de ancoragem para completar a curva.

Desenho de um segmento reto seguido por um segmento curvado (parte 2)

A. Posicionamento da ferramenta Caneta
B. Arrastando a linha de dire¢do

C. Novo segmento curvado concluido
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Desenho de curvas sequidas de linhas retas

Usando a ferramenta Caneta, arraste para criar o primeiro ponto suave do segmento
curvo, e solte o botdo do rato.
Reposicione a ferramenta Caneta no local em que deseja que o segmento curvo termine;

arraste para completar a curva e solte o botdo do rato.

L ]
Desenho de um
[ ]
/ Q segmento curvado
sequido por um
L ]
segmento reto (parte 1)
A B

A. Primeiro ponto suave do segmento curvado concluido e a ferramenta Caneta
posicionada sobre a extremidade

B. Arrastando para completar a curva

Posicione a ferramenta Caneta sobre a extremidade selecionada. Quando ela estiver
posicionada corretamente, um icone de conversdo de pontos aparecera junto a ferramenta.
Cliqgue no ponto de ancoragem para converter o ponto suave num ponto de vértice.

Reposicione a ferramenta Caneta no local em que deseja que o segmento reto termine,

e clique para concluir o segmento reto.

Desenho de um

segmento curvado

seguido por um

segmento reto (parte 2)

C. Posicionando a ferramenta Caneta sobre uma extremidade existente
D. Clicando na extremidade

E. Clicando no préximo ponto de vértice
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Desenho de dois segmentos curvados conectados por um
vértice

Usando a ferramenta Caneta, arraste para criar o primeiro ponto suave de um segmento
curvado.

Reposicione a ferramenta Caneta e arraste para criar uma curva com um segundo ponto
suave; em seguida, mantenha pressionada a tecla Alt (Windows) ou Option (Mac OS) e
arraste a linha de direcdo na direcao da extremidade oposta para definir a inclinacdo da
préxima curva. Solte a tecla e o botdo do rato.

Esse processo converte o ponto suave num ponto de vértice dividindo as linhas de
direcdo.

Reposicione a ferramenta Caneta no local em que deseja que o segundo segmento
curvado termine, e arraste um novo ponto suave para concluir o segundo segmento

curvado.

Desenho de duas curvas

A. Arrastando um novo ponto suave
B. Pressionando Alt/Option para dividir as linhas de direcdo enquanto arrasta e
oscilando a linha de direg¢do para cima

C. Resultado apds reposicionar e arrastar pela terceira vez
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Sobre cores /amostras

Amostras sao cores, tons, gradientes e padroes nomeados. As amostras associadas
a um documento aparecem no painel Amostras. Essas amostras podem aparecer
individualmente ou em grupos.

Pode abrir bibliotecas de amostras a partir de outros documentos do lllustrator e varios
sistemas de cores. As bibliotecas de cores aparecem em painéis a parte e ndo sdo salvas
com o documento.

O painel Amostras e os painéis de bibliotecas de amostras podem conter os seguintes

tipos de amostras:

Cores de processo

Uma cor de processo é impressa com o uso de uma combinacdo das quatro tintas de
processo padrao: ciano, magenta, amarelo e preto. Por padrao, o lllustrator define novas

amostras como cores de processo.

Cores de processo globais

Uma cor global é automaticamente atualizada no seu trabalho artistico conforme a
edita. Embora todas as cores especiais sejam globais, as cores de processo podem ser
globais ou locais. E possivel identificar amostras de cores globais pelo icone de cor global
(quando o painel esta na exibicdo em lista) ou por um tridngulo no canto inferior (quando

o painel esta na exibicdo em miniatura).

Cores especiais

Uma cor especial é um tinta pré-misturada que é utilizada no lugar de tintas de processo
CMYK ou em acréscimo a essas tintas. E possivel identificar amostras de cores especiais
pelo icone de cor especial (quando o painel esta na exibicdo em lista) ou por um ponto

no canto inferior (quando o painel esta na exibicdo em miniatura).
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Gradientes

Um gradiente é uma mistura gradual entre duas ou mais cores ou tons da mesma cor ou
de cores diferentes. Cores de gradiente podem ser atribuidas como cores de processo
CMYK, cores RGB ou uma cor especial. A transparéncia aplicada a um limite de gradiente
é preservada quando o gradiente é salvo como amostra de gradiente. Os valores de
proporcdo e angulo de gradientes elipticos (criados com o ajuste da propor¢do ou do

angulo de um gradiente radial) ndo sdo salvos.

Padroes

Padrées sdo caminhos repetitivos (lado a lado), caminhos compostos, texto com

preenchimentos sélidos ou nenhum preenchimento.

Nenhum

A amostra ‘Nenhum(a)’ remove o tracado ou o preenchimento de um objeto. Ndo é

possivel editar nem remover essa amostra.

Registo

A amostra de registo é uma amostra integrada que faz com que os objetos preenchidos
ou tracejados como ela sejam impressos em todas as separagdes em uma impressora
PostScript. Por exemplo, marcas de registo usam a cor de Registo, para que as chapas de
impressao possam ser alinhadas com precisdo em um prelo. Ndo é possivel remover essa
amostra.

Nota: Se usar a cor de Registo para digitacdao e, em seguida, separar o arquivo e imprimi-
lo, a digitacdo talvez ndo seja registada corretamente, e a tinta preta pode ter uma

aparéncia turva. Para evitar isso, use tinta preta para digitacao.
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Grupos de cores

Grupos de cores podem conter cores de processo, cores especiais e cores globais de
processo. Eles ndo podem conter amostras de padrdes, gradientes, registos ou do tipo
Nenhum. Os grupos de cores sdo criados com base em harmonias, com o uso do painel
Guia de cores ou da caixa de didlogo Editar cores/Recolorir arte. Para colocar amostras

existentes em um grupo de cores, selecione essas amostras e clique no icone Novo

A B

Amostras

e |

P4 (Nenhum] 7 C
[Registro] 3 D

4 Orass Green 4 E

V4 Lavender
4 Light Red - F

grupo de cores , no painel Amostras. E possivel identificar um grupo de cores pelo icone
e pasta.

Também pode criar tons no painel Amostras. Um tom é uma cor de processo global ou
uma cor especial com intensidade modificada. Tons da mesma cor sao vinculados de
tal forma que, se vocé editar a cor de uma amostra de tom, todas as amostras de tons
associadas (e os objetos com elas pintados) mudarao de cor, embora os valores de tom
permanecam inalterados. Tons sdo identificados por uma porcentagem (quando o painel

Amostras esta na exibicdo em lista).
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Visdo geral do painel Amostras

Use o painel Amostras (Janela > Amostras) para controlar todas as cores, gradientes e
padrdes do documento. E possivel nomear e armazenar qualquer um desses itens para
acesso instantaneo. Quando o preenchimento ou o tracado de um objeto selecionado
contém uma cor, um gradiente, um padrao ou um tom aplicado a partir do painel
Amostras, a amostra aplicada fica realgcada nesse painel.
Painel Amostras na exibigcdo em Lista pequena
A. Cor especial
B. Cor global
C. Preenchimento ou tracado de Nenhum
D. Amostra de registros (impressa em todas as chapas)
E. Simbolo CMYK (quando o documento estd aberto no modo CMYK)
F. Simbolo RGB (quando o documento estd aberto no modo RGB)
G. Botéo do menu Biblioteca de amostras
H. Botdo do menu Mostrar tipos de amostra
I. Botdo Opgdes de amostra
J. Botéio Novo grupo de cores

K. Botdo Nova amostra

oy
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Apresentacdo

Este mdodulo pretende concluir o projeto elaborado nos médulos anteriores,
trabalhando fundamentalmente a paginacao final do trabalho e a sua preparacdo para
impressdao, mas também todos os aspetos transversais que fazem parte do processo da
edicao.

O docente devera acompanhar a aprendizagem que devera partir sob forma de
proposta de trabalho a realizar. Este mdédulo podera estar articulado com um projeto

do médulo de fotografia e/ou com um projeto da disciplina de Design Grafico.

Objetivos da aprendizagem

Utilizar as ferramentas de edi¢cdo de imagem;
Utilizar corretamente as ferramentas especificas;
Praticar os aspetos transversais da edicdo eletrdnica;
Realizar corretamente artes finais;

Otimizar fluxos de producao, a semelhanca dos utilizados em meios profissionais.
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Ambito dos conteudos

Digitalizacdo de opacos e transparéncias
Preparagdo dos conteldos bitmap
Maquetizacao

Arte finalizacdo

Manual do Aluno
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Efeito de vetorizacao real através do
Photoshop

01. Para criar este vetor com uma foto sera necessario um bom dominio do Photoshop
e da ferramenta Pen Tool. Para ter um resultado detalhado serdo necessdrias algumas
horas ou até dias de trabalho, por isso algumas vezes vale mais a pena realizar este
tipo de trabalho em softwares que trabalham com vetores. No fim o resultado pode ser
idéntico, porém com o Photoshop terd um bitmap que, ao contrario do vetor, ndo ird

permitir um redimensionamento sem perda de qualidade.

Pressione Ctrl+0 e abra a foto escolhida para ser trabalhada, para este tutorial.

02. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, defina sua cor de Foreground
com a cor #D9IBAS8D, pressione a letra P do teclado para selecionar a Pen Tool para criar
a pele va clicando e contornando todas as dreas de pele que estejam visiveis, na imagem

abaixo comegamos a contornar o brago.
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03. Na parte dos dedos nao se preocupe em fazer divisdes exatas ou como na imagem
gue estamos usando os dedos se confundem e somem nos cabelos por isso ndo se
preocupe em fazer esta parte com muita exatidao, pois eles serdo cobertos pelos cabelos

mais a frente.

04. Ao terminar de contornar todas as areas de pele da imagem, cligue com o botdo
direito dentro do contorno e escolha a opc¢ao Fill Path, note que em algumas areas como
as areas proximas a roupa e os cabelos ndo estdao bem desenhados, mas ndo se preocupe,

pois mais a frente isto ird desaparecer.
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05. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, desta vez faremos o contorno do
rosto, ndo se preocupe com olhos, boca e nariz neste momento, faga apenas o contorno
como foi feito anteriormente com o corpo e preencha a selecdo com a cor #E2C59B caso

esteja a usar a imagem do tutorial.

06. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, desta vez faremos o contorno
do vestido, escolha a cor desejada mas escolha uma cor escura (com exce¢do da cor
preta), pois mais adiante usaremos cores mais claras para criar os detalhes do vestido
e o preto para criar as areas de sombra. Neste tutorial usamos a cor #196339, proceda

COMO nos passos anteriores.
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07. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, desta vez faremos a parte dos
cabelos, para o cabelo da fotografia usada neste tutorial foi usada a cor #784234, que é
a cor de base para cabelos pretos, caso seja feito num cabelo loiro ndo comece com o
amarelo e sim com um tom marrom, pois o que estamos a fazer agora é apenas a base,
repita o mesmo procedimento realizado nos passos anteriores, a sua imagem devera

ficar como a imagem abaixo.

=]}

;] Layers ™, Channels \Pﬂhﬁ \_ v
08. Com a base pronta agora é a hora de adicionar as Normal | Opacity: 100% ¥ |
leck: [ ¢+ @ Fill: 100% » |

- Background copy 3

sombras, quanto mais sombra mais realista a imagem

ird ficar, quanto menos sombra menos realista e com

mais cara de Cartoon a sua imagem ird ficar, comece | *® | g e
por duplicar a fotografia original pressionando Ctrl+], ® smgrm:mz
faca isso 4 vezes, 1 para o corpo, 1 para o vestido, 1 | |]L_w3
para o rosto e 1 para o cabelo, e deixe as layers como
E_:f Background copy

na foto abaixo.
Layer 2

9.0 0 ® 3 3]
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| Layers ™ _Channels ™ Paths N 0 |
09. Agora pressione Ctrl+Alt+G (Ctrl+G na versdo CS — v ] Opacity: [100% >

do Photoshop), ou em Layer> Create Clipping Mask, |'o* L o @  Fiioox 21

aplique nas layers que contenham a fotografia usada, ®
a sua paleta de layers deve ficar como a da imagem L

abaixo. ®

0.0 0 &3 3]

10. Clique com a tecla Ctrl sobre as miniaturas das layers que contém os contornos feitos
para ativar a selecdo, em seguida va a Select> Inverse ou pressione Ctrl+Shift+l, clique na
layer da fotografia que esta acima desta layer e pressione Delete, faca isto com todos os
contornos feitos, com isto estamos a apagar da fotografia usada as partes que ndo sao

necessarias.

11. Agora clique na layer que contém a imagem do corpo e depois va a Image>
Adjustments> Desaturate ou pressione Ctrl+Shift+U, isto ird deixar a fotografia a preto
e branco, em seguida va a Image> Adjustments> Posterize, defina um valor entre 8 e
9 e pressione Ok, faca isto em todas as layers de fotografia que estamos a trabalhar
(corpo, rosto, cabelo e vestido), porém cada parte do corpo possui um valor diferente no
filtro Posterize, isto vai muito da fotografia escolhida e de quanto de detalhes queremos

trabalhar na foto.
12. Clique na foto do corpo e pressione Ctrl+Shift+Alt+N para criar uma nova layer e
pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou va a Layer> Create Clipping Mask,

pressione a letra D do teclado para definir a sua cor de Foreground como preta (#000000),
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pressione a letra P do teclado para selecionar a Pen Tool e crie sele¢des nas areas escuras
(sombras) do corpo primeiro, pegando a cor preta com o tom de cinza mais préximo, a
cor de base que foi feita antes aqui esta representada pelo cinza claro, por isso todas as

outras tonalidades serdo trabalhadas mais adiante.

13. Retire a visualizacdo da layer que acabou de ser trabalhada e pressione
Ctrl+Shift+Alt+N para criar mais uma layer, aplique outro Clipping Mask pressionando
Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou indo a Layer> Create Clipping Mask, pressione
a letra P para selecionar a Pen Tool e desta vez selecione a cor preta junto com mais 2
tonalidades de cinza, repita o processo de cricdo de layer e selecdo em redor da cor até
ter selecionado todas as cores, sempre que for criar uma nova layer retire a visibilidade
da layer anterior, no tutorial foram criadas 4 layers de selecdes em preto, porém isso
pode variar dependendo da imagem ou nivel de detalhe no filtro Posterize. Agora defina
a sua cor de Foreground em branco (#ffffff), pressione Ctrl+Shift+Alt+N para criar uma
nova layer e depois pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou va em Layer>
Create Clipping Mask, pressione a letra P do teclado para selecionar a Pen Tool e crie
uma selegdo nas dareas claras da imagem, no tutorial foram feitas duas layers pegando
do tom mais claro para um escuro e depois do claro para dois tons mais escuros, depois
de feito isso ative a visualiza¢do de todas as layers (com excecao da layer da fotografia do

corpo) e mude o modo de blend das layers que acabamos de criar para Soft Light.
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14. Diminua a opacidade das layers que acabamos de trabalhar (selecGes de preto
e branco do corpo) para 30%, clique com a tecla Ctrl pressionada na miniatura da
primeira layer de sombra (selecdo em preto) para ativar a selecdo em redor, pressione
Ctrl+Shift+Alt+N para criar uma nova layer e va a Select> Modify> Contract e defina
um valor de 3 pixels, clique em Ok,
pressione a letra G do teclado para
selecionar a Paint Bucket Tool e
preencha a selecdo com a cor preta,
mude o modo de blend da layer para
Soft Light e defina o valor de 30%
para Opacity. Faca isto para cada
layer em preto e branco (do corpo)
que acabamos de trabalhar, sua

imagem ird ficar assim.

15. Agora iremos trabalhar o vestido, o processo é o mesmo, pressionar Ctrl+Shift+Alt+N
para criar uma nova layer, Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou va a Layer> Create
Clipping Mask, pressionar a letra P
do teclado para selecionar a Pen Tool
e ir criando as selecbes sempre em
novas layers e retirando a visibilidade
da layer anterior, ao final mudar o
modo de blend da layer para Soft

Light com opacidade de 30%.
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16. O proximo passo é trabalhar o rosto, como o mesmo processo que fizemos

anteriormente, por enquanto trabalhe apenas o rosto sem mexer nos olhos e |abios.

17. Agora trabalharemos o cabelo, que é a parte mais complicada e demorada, para
comecar faca todo o processo que foi aplicado noutras partes do corpo e descrito

anteriormente.
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18. Adicione mais detalhes na cor branca e na cor preta para deixar os cabelos mais
realistas, criando inclusivé a direcdo do penteado para dar mais realismo, como pode ser

observado na imagem abaixo.

19. O ultimo passo para o cabelo é criar alguns fios que saem para dar mais realismo,
pressione Ctrl+Shift+Alt+N para criar uma nova layer, pressione a letra G do teclado para
selecionar a Paint Bucket Tool e pinte esta nova layer com a cor cinza clara, coloque esta
layer abaixo das outras para criar um fundo cinza. Este fundo servird apenas para criar
um contraste e ajudar na visualiza¢do dos tragos, novamente crie uma nova layer acima
da layer do cabelo pressionando Ctrl+Shift+Alt+N, ndo crie um Clipping Mask para esta
layer, defina sua cor de Foreground com a cor #5E2E24, pressione a letra P do teclado
para selecionar a Pen Tool e desenhe pequenos fios saindo do cabelo como mostrados

nas fotografias abaixo.
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20. Abaixo pode ver as areas que foram criadas, selecionadas e depois como ficou.

21. O préximo passo sera criar os elementos do rosto, comegando pelas sobrancelhas,
pressione Ctrl+Shift+Alt+N para criar uma nova layer acima da layer do rosto, defina a
sua cor de Foreground para #5E2E24, pressione a letra P do teclado para selecionar a
Pen Tool e crie a selecdo em redor da sobrancelha, depois clique com o botao direito do

rato e escolha a opggao Fill Path e pressione Ok.
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22. Pressione Ctrl+Shift+alt+N para criar uma nova layer, pressione a letra P do teclado
para selecionar a Pen Tool e crie uma selecdo em redor da parte branca do olho direito,

preencha com a cor #A18D97, nunca com a cor branca pura.

23. Pressione Ctrl+Shift+Alt+N para criar mais uma layer e retire a visualizacdo da outra
layer do olho, pressione a letra P do teclado para selecionar a Pen Tool e crie uma
selecdo em redor da iris, preencha a selecdo com a cor #343C31. Pressione novamente
Ctrl+Shift+Alt+N para criar uma nova layer e retire a visualizacdo da layer que estavamos
a trabalhar (a layer da iris), pressione a letra P do teclado para selecionar a Pen Tool e
desenhe em redor da pupila, preencha a selecdo com a cor preta, ative a visualizacdo das

2 outras layers do olho para ver como esta ficando.
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24. Pressione Ctrl+Shift+Alt+N para criar uma nova layer onde faremos os cilios, crie a
selecdo e preencha com a cor preta, logo apds pressione novamente Ctrl+Shift+Alt+N
para criar uma nova layer e posicione esta layer abaixo das outras layers do olho,
pressione a letra P do teclado para selecionar a Pen Tool e desenhe as areas de sombra
do olho. No final preencha a selecdo com a cor preta, mude o modo de blend da layer
para Soft Light, assim teremos 3 layers com sombras e dreas escuras e 2 de areas claras,
deixe as layers de areas claras com modo de blend Soft Light e opacidade em 100%, as

areas de sombra (pretas) ficam com modo de blend em Soft Light e opacidade em 80%.

25. Cligue na layer que contém a parte branca do olho e pressione Ctrl+Shift+Alt+N
para criar uma nova layer e depois pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou
va a Layer> Create Clipping Mask, defina a sua cor de Foreground em branco (#ffffff),
pressione a letra P do teclado para selecionar a Pen Tool e desenhe duas dreas como
as mostradas na foto abaixo, preencha com a cor branca e defina o valor de 70% para a

opacidade da layer.

26. Pressione Ctrl+Shift+Alt+N para criar outra layer e depois pressione Ctrl+Alt+G (Ctrl+G
no Photoshop CS) ou va a Layer> Create Clipping Mask, pressione a letra P do teclado
para selecionar a Pen Tool e desenhe duas areas como as da foto abaixo, preencha as

selecOGes com a cor preta e mude o modo de blend da layer para Soft Light.
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27. Agora clique na layer da iris e depois pressione Ctrl+Shift+Alt+N para criar uma nova
layer, pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou va a Layer> Create Clipping
Mask, pressione a letra B do teclado para selecionara Brush Tool, defina um tamanho de
3 pixels, e desenhe um contorno ao redor da drea verde usando a cor preta, pressione
Ctrl+Shift+Alt+N para criar uma nova layer e pressione Ctrl+Alt+G (Ctrl+G no Photoshop
CS) ou va a Layer> Create Clipping Mask, pressione a letra B do teclado para selecionar a
Brush Tool novamente e com a cor branca desenhe alguns pontos em volta da area verde

do olho, mude o modo de blend da layer para Soft Light com 70% de opacidade.

28. Pressione Ctrl+Shift+Alt+N para criar uma nova layer acima da layer da pupila,
pressione a letra B do teclado para selecionar a Brush Tool com tamanho de 1 pixel na

cor branca, desenhe um ponto como o da fotografia abaixo.
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30. Para o olho esquerdo basta duplicarmos o olho direito, para isso criamos um layer
set (uma pequena pasta contendo todas as layers do olho), para criar a layer set, clique
no icone de uma pasta que fica no rodapé da paleta de layers, isto ird criar uma pequena
pasta na sua paleta de layers, clique e arraste todas as layers do olho para dentro desta
pasta. Feito isto, clique com o botdo direito do rato sobre a pasta e escolha a opcdo
Duplicate Layer Set, clique na pasta que foi criada e va a Edit> Transform> Flip Horizontal,
pressione a letra V do teclado para selecionar a Move Tool e mova o olho para a posi¢ao

correta, pressione Ctrl+T para acertar o angulo correto do olho em relagdo ao rosto.

31. Agora faremos os labios, escolha uma cor qualquer, para este tutorial usamos um
vermelho escuro (#A7545B), pressione Ctrl+Shift+Alt+N para criar uma nova layer e
depois pressione a letra P do teclado para selecionar a Pen Tool, crie o contorno dos
labios e preencha na cor escolhida, novamente pressione Ctrl+Shift+Alt+N para criar
outra layer, pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou va a Layer> Create Clipping

Mask e crie uma selecao em redor das areas escuras dos labios.
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32. Crie também a divisdo dos labios, no final mude o modo de blend da layer para Soft

Light com opacidade em 55%.

33. Crie mais algumas camadas repetindo os passos feitos em outras partes do corpo até

achar que conseguiu um bom resultado.

34, Para o nariz, pressione Ctrl+Shift+Alt+N para criar uma nova layer e pressione a

letra P do teclado para selecionar a Pen Tool, crie uma selecdo em redor das narinas e
defini¢cdes do nariz e preencha com a cor preta, mude o modo de blend da layer para

Soft Light.

e
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35. Abaixo a imagem no final.

36. Com algumas variacdes de Background.
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Gradient Tool ou Ferramenta Degrade.

Gradient Tool ou Ferramenta Degradé, é uma ferramenta secundaria da Paint Bucket
Tool, ou seja, para aceder a esta ferramenta deve clicar sobre a Paint Bucket Tool e manter
o botdo pressionado até ver o icone da Gradient Tool, por isso o atalho de teclado é o
mesmo da Paint Bucket Tool. Porém a ferramenta tem uma funcao bem diferente, ela
cria transicOes entre duas ou mais cores de forma suave com a possibilidade de aplicacao
de 5 efeitos distintos entre outras opc¢des, que sdo apresentadas na barra de opcdes da

ferramenta como veremos a seguir.

Gradient Tool - Ferramenta Degradé
Tecla de atalho: Letra G do teclado

Barra de Opg¢odes da Gradient Tool

Ao aceder a Gradient Tool pela paleta de ferramentas ou atalho de teclado vemos a

barra de opgdes da ferramenta no alto da tela com as seguintes op¢des.

Degradés

Na barra de opg¢des a primeira caixa da esquerda para a direita apresenta a opc¢do de
Degradé que apresenta as cores que vocé tem como Foreground e Background com o
efeito de Degradé, ao lado vemos uma pequena seta, que ao ser clicada revela outras

combinac¢des de Degradé que podem ser escolhidas e customizadas.

Customizando um Degradé
Para criar um Degradé customizado basta clicar duas vezes sobre a caixa de Degradé (a

da fotografia anterior) e serd aberta a caixa do Editor de Degrade.

1. Nesta parte tem todos os Degradés ja criados e aqueles que criar e salvar também

ficardo nesta caixa para posterior uso.

3
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2. Ao clicar nesta seta um menu abrird mostrando as vdrias opg¢des de customizacdo para

a caixa de Degradés.

3. Nesta area pode salvar e dar um nome a um novo Degradé que cria nas opgdes que

estdo abaixo, e que futuramente estara na caixa de Degradés logo acima.

4. Nesta caixa definimos o tipo de Degradé, existem duas op¢des, Solid ou Noise, cada

uma delas apresenta opgoes de customizacdo diferentes.

5. Cligue sobre esta seta para definir a Opacidade da cor neste ponto, note que ao clicar
nesta seta a caixa Opacity(9) logo abaixo fica ativa, dando a possibilidade de edi¢do da

opacidade da cor.

6. Cligue sobre esta seta para definir a cor do Degradé nesta parte, isto pode ser feito de
duas maneiras, clicando duas vezes sobre esta seta a caixa Color Picker ira abrir dando
a possibilidade da escolha de cor, e usando a opc¢ao Color(10) logo abaixo que ao ser

clicada oferece as op¢bes Foreground, Background e User Color.

7 e 8. Contém as mesmas func¢des de 5 e 6 controlando a cor e opacidade da direita.

Para criar mais pontos de cor basta clicar acima da barra de Degradé onde temos as setas
de control e para que aparecam mais pontos e assim criar Degradés diferenciados.

A opcdo Smooth controla a suavizacdo da transicdo de cores.

Ao se escolher a opcdo Noise a caixa seguinte abrir-se-3, ela apresenta opc¢des

diferenciadas em relagdo a opgao Solid.

Roughness - Defina a suavizagao entre as cores.

Color Model - Permite a edi¢cdo de cores em trés modos diferentes, RGB, HSB e LAB.
Restrict Colors - Ative esta opcao caso queira retirar cores fora da gama de impressao.
Add Transparency - Ative esta opgdo para ter transparéncia no seu Degradé.
Randomize - Ao ser clicado ird randomizar o Degradé, oferecendo outras opg¢des dentro

do modo de cor escolhido.
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Opc¢oes de Degradé

Para criar um Degradé é simples, com a Gradient Tool selecionada basta clicar num ponto
do seu documento arrastar e soltar noutro ponto, temos 5 op¢des de Degradé como as

mostradas abaixo.

1 - Linear Gradient
2 - Radial Gradient
3 - Angle Gradient
4 - Reflected Gradient

5 - Diamond Gradient

Abaixo temos todos os Degradés aplicados.

Mode e Opacity

Em mode é possivel definir o modo de blend para o Degradé, ao clicarmos no menu
Mode uma série de opgdes sdo mostradas, em Transparency podemos definir o valor da

transparéncia que o Degradé terd apds ser aplicado.

Reverse, Dither e Transparency

A opcdo Reverse muda a direcdo do Degradé de forma inversa ao ser clicado, Dither
suaviza a transicdo de cores, por mais imperceptivel que seja é sempre aconselhavel
gue esta opc¢ao esteja sempre ativada e transparency define a transparéncia através das
cores usadas no Degradé. Quando usadas no modo de Edicdo de Degradé, ela pode ser

ativada ou desativada pela barra de opgdes.

4
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Paleta Layers

O controle das camadas é feito pela Palheta “Camadas” ou “Layers”. Se ndo vé essa

palheta va a Window > Layers e ela aparecera.

Como pode ver na imagem acima, as camadas podem ser sobrepostas. As de baixo ficam
atrds das de cima. Assim pode editar o conteldo de cada camada separadamente e
mové-las independentemente também.

No exemplo acima temos uma camada totalmente branca (pode ver pela miniatura ao
lado do nome da camada como ela é, neste caso, é toda branca). Em cima dela temos
uma camada totalmente preta. Como ela estd acima da camada branca é ela que aparece.
Depois vemos uma camada vazia. Tudo que é “vazio” no Photoshop é representado por
esse quadriculado cinza.

Depois temos uma camada com um quadrado vermelho. Acima dela temos um quadrado
amarelo. Como consequéncia o amarelo fica na frente do vermelho, quando vemos o

resultado final.
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Visualizacdo

Todas elas tém um “olho” ao lado esquerdo. Ele serve para “esconder” a camada
provisoriamente. Se existe o olhinho ali quer dizer que estd a ver a camada no resultado
final. Se clica nele o olhinho desaparece. Isso significa que a camada ainda existe, mas

nao a esta a ver no resultado final.
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Veja na imagem acima: o quadrado amarelo esta sem o olhinho (é sé clicar em cima e
ele desaparece). Por isso ndo conseguimos ver esse quadrado na imagem. Se quisermos

vé-lo novamente é sé clicar no quadradinho vazio onde estava o olho.

Nome da camada

O nome da camada é muito importante para nos organizarmos entre varias camadas.
Conforme criamos novas camadas, o Photoshop nomeia-as automaticamente como
“Layer 1", “Layer 2", “Layer 3" e assim por diante.

Como isso ndo diz nada sobre as camadas, o melhor a fazer é renomear cada uma com
algo que diga o que elas sdo. Para fazer isso clique duas vezes exatamente em cima do

nome atual. Agora é sé substituir e pressionar Enter.

Formatos de camadas

Fora o olhinho e o nome, as camadas tém representacdes um pouco diferentes de acordo
com o seu tipo.

Camadas bitmap: ndo se preocupe em saber tecnicamente o que é “bitmap” ainda. Uma
camada bitmap é uma camada que contém uma imagem qualquer (como os quadrados
coloridos dos exemplos acima, ou uma foto!).

Camada de texto: como o nome diz, uma camada de texto contém um texto! Ela é
representada por um quadrado branco com um “T” dentro. Esse texto pode ser editado
a qualquer momento.

Camada vetorial: é o resultado da criacdo de uma “forma”. Sempre que cria formas
(shapes) com ferramentas, como a Pen Tool ou Shape, como o coragdo acima, o resultado
vai ser uma camada vetorial. Ndo se preocupe em saber tecnicamente o que é um vetor
ainda. Essa camada é representada por uma cor (a cor da forma) e um retangulo cinza
com a forma dentro em branco (como podem ver ali em cima o retangulo cinza tem um
coracdo dentro).

Outras camadas: existem também camadas de ajuste.
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Comecando a trabalhar com camadas

Ao abrir uma foto (Ctrl+0) vai ver uma sé camada chamada “Background”. Essa camada
tem um cadeado do lado, o que significa que ela ndo pode ser movida. E nem queremos

isso! Vamos deixar a camada Background intacta.

Para criar uma nova camada vamos utilizar o atalho Ctrl+Shift+Alt+N. Se ndo quiser

decorar agora, pode clicar no icone de New Layer, que fica 1a em baixo da Palheta Layers.

Ao clicar, uma nova camada transparente sera criada. Como ela é transparente (ndo tem
nada) ndo vera diferenca nenhuma na imagem final!
Agora vamos selecionar essa camada (é so clicar em cima dela uma vez). Assim podemos

comecar a edita-la. Selecionando a ferramenta Brush (B) vamos pintar algo nessa camada.
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Agora, por mais que pareca que estragamos totalmente a fotografia, ndo ha com o
gue se preocupar. A mancha vermelha estd numa camada separada, entdo a qualquer
momento podemos mové-la, edita-la e até apaga-la.

Vamos criar outra camada com outra mancha.

Se quisermos mover as camadas, é so utilizar a ferramenta Mover (V). Se quisermos
mudar a posicao da camada, é so clicar nela e manter o botdo do rato pressionado. Ai

movemo-la para baixo ou para cima na hierarquia de camadas.

Agora a mancha amarela esta debaixo da outra (da para ver o resultado na imagem!).
Se quisermos retirar essas camadas é sé estar com a ferramenta Mover (V) selecionada e

utilizar a tecla “Delete” no teclado. Se ndo quiser utilizar o teclado, clique no icone “Lixo”
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que fica Ia em baixo da palheta Layers.

Terminou, fez vdrias edi¢des, mas a imagem inicial ainda estd intacta!

£ 5 F 1971027 _0h.jpg @ 12,5% (RGET) £ __F_.*
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Recortar uma silhueta

€ ) ©) 20071027_s54pg @ 12,5% (RGET) o | 6
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Na hora de retocar uma imagem ou de trabalhar com arquivos graficos para fazer

composi¢bes, uma das tarefas mais habituais é realizar sele¢des de areas, para recortar

) 6 FH11027_05jpg @ 12,5% (Layer 1, RGBS) =] =)
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e colar na composi¢ao ou retoque fotografico. Neste workshop para novatos em

Photoshop, vamos explicar o modo de trabalho da ferramenta de selegdo poligonal, que
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seria a mais facil para comecar a fazer selecoes complexas de areas irregulares.
O mais importante de Photoshop, pelo menos para comecar, € dominar as camadas e
selec¢des. Este seria o primeiro tutorial para conhecer as sele¢cdes complexas, para realizar

recortes de areas da imagem em que se poderdo utilizar composicdes. Nos préximos
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artigos veremos outras ferramentas para fazer o trabalho com maior detalhe e precisao,

utilizando ferramentas mais complexas.

Ferramentas de laco poligonal
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N3o obstante, comecemos por ver onde estd a ferramenta de laco poligonal. Encontra-
se junto com a ferramenta de lagco e com a de lago magnético. Se tivermos qualquer
destas ferramentas selecionadas, para aceder ao lago poligonal simplesmente temos
que clicar com o rato continuamente durante uns segundos, para que nos mostre e
possamos seleciona-la.

Uma vez selecionada podemos experimentar com ela fazendo umas provas. Clicamos
em qualquer parte da imagem e com isso comegaremos a construgao da selegdo. Logo
podemos ir clicando em diversas areas da imagem para ir definindo o perimetro da
selecdo.

Uma vez definido o perimetro da selecdo, devemos fechda-la para terminar a sua definicao
e poder operar com ela. Quando se fecha a sele¢ao aparece um pequeno simbolo ao
lado do cursor do rato com um circulo. Isto quer dizer que, se clicarmos a selec¢do, ficara
fechada e com isso perfeitamente definida.

Outra opcdo para fechar uma selegao poligonal é clicar duas vezes em qualquer parte da
tela. Com isso, fechar-se-a a selecdo unindo o primeiro ponto com o lugar onde se fez o

clique duplo.
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Selegcéo de uma silhueta com o lago poligonal

A selecdo tem que comecar por um ponto e acabar no mesmo ponto, por isso podemos
escolher qualquer ponto que nos interesse. Entdo, vamos fazendo ponto a ponto, o
percorrido da silhueta. Alguns conselhos para fazer uma boa selecao seriam:

Ter em conta que quantos mais pontos colocar, melhor definida estara a selecao.

N3o cligue muito rapido no botdo do rato entre ponto e ponto, pois se dois cliques muito
juntos forem confundidos por um clique duplo fechar-se-a a selecao.

Faca bastante zoom para engrandecer a visualizacdo da imagem, para poder fazer a
selecdo sobre uma drea maior onde tiver melhores possibilidades de marcar pontos nos
lugares corretos.

Se for reduzir a imagem de dimensdGes, convém fazer a selecdo da silhueta antes de
reduzi-la. Assim, mesmo que tenha algumas imperfeicGes, dissimular-se-do ao reduzir a
imagem. Se o fizer com a imagem reduzida diretamente ver-se-do os defeitos da selecao.
Se se equivocar, por deixar de selecionar uma area que lhe interessava ou por selecionar
uma area que ndo desejava, ndo se preocupe. O melhor é que continue até terminar a
selecdo e logo tire ou adicione mais area. Para tirar uma selecao a outra tem que apertar
a tecla alternativa (Alt) quando comecar a fazer a sele¢do que quer tirar a qual ja tem

“o-n

realizada (vocé verd que aparece um sinal de menos ao lado do cursor do rato).
Para adicionar uma selecdo a outra utilize a tecla maiusculas (também chamada Shift,
que tem a seta para cima) no momento que comegar a fazer a nova sele¢do que quer
adicionar (vera que aparece um sinal “+” ao lado do cursor do rato).

Quase sempre é bom utilizar um suavizado na sele¢do. E nos casos em que a silhueta
selecionada for muito grande ou que iremos cola-la em cima de outra imagem, seria

bom experimentar com diversas configuracdes de esfumado.

Seja paciente, porque é uma operac¢ao delicada e um clique em falso pode prejudicar

o

R
|
CURSO TECNICO DE ARTES GRAFICAS | 103 /f[;':j&

Ty

e
*

wh



EDICAO ELETRONICA

muito a selecdo realizada durante varios minutos.
Nos préximos artigos explicaremos como fazer a selegao com a ferramenta pluma, que
nos permitird resultados muito melhores, apesar do funcionamento se tornar mais

complexo.
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Selecdes com a varinha magica

A ferramenta varinha magica de Photoshop serve, como dizia, para fazer sele¢des. As
selecOes que se podem fazer com a varinha sao de qualquer tipo, quadradas, redondas,

poligonais ou de formas irregulares, portanto é bastante versatil. O uso é o seguinte:

Selecionamos a ferramenta varinha magica, que tem esta forma:

Logo, podemos clicar em qualquer parte de uma imagem com a varinha e entdo
obteremos uma selecdo dentro da imagem. Para estabelecer os limites da selegao, o
Photoshop avaliara as cores que ha a lado do pixel marcado com o clique e se forem o
mesmo, ou similares, a selecdo também abarcara esses pontos. Desta maneira, continua
mostrando cores da imagem e adicionando a selecdo se forem parecidos. O resultado é
gue a selecdo vai crescendo pelas partes daimagem que tiverem uma cor homogénea ou
similar. Sendo assim, os limites da selecdo criada serdo marcados pela forma da prépria
imagem e as cores que tiver.

A varinha serve, por exemplo, para selecionar silhuetas numa fotografia. Se tivermos
uma foto com um céu homogéneo e utilizarmos a varinha sobre o céu, selecionar-se-a
toda a area azul. Podemos ver na seguinte imagem uma selecao feita com a varinha

magica do céu desta foto tirada em Valéncia.

Como veremos na imagem, selecionou-se a maioria do céu, ajustando os limites da
selecdo a das figuras captadas na foto. Como veremos, nem todo o céu foi selecionado,
porque ha partes do mesmo que nao sdao muito parecidas com a cor azul sobre a qual
clicdmos inicialmente e, portanto, ndo se mostraram como cores parecidas e ndo se

carregaram na selecgdo.
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Opc¢oes da varinha mdgica de Photoshop

Com as opgoes da ferramenta varinha magica, podemos modificar o seu comportamento,
para, por exemplo, dizer qudo estrito ou tolerante deve ser a amostragem da imagem
para definir as bordas da selecdo. As opcdes de qualquer ferramenta de Photoshop
podem ser vistas geralmente na parte de cima da janela do programa e se nao aparecem,
podemos forgar que se mostrem com o menu Janela - Opgoes.

A mais importante das opg¢des de varinha é a Tolerancia. Que permite especificar com

Varita magica
B ——

um numero tdo tolerante ou estrito a mudancas nas cores como for a sele¢cdo. Ao
menor valor de tolerancia, mais estrita serd a amostragem de cores. De tal modo que,
se colocarmos tolerdncia zero, sé se selecionariam as partes continuas ao ponto onde
fizemos o clique da imagem que tiver a mesma cor. Se a tolerancia for muito alta a
selecdo expandir-se-4, embora as cores variem mais. Se ao fazer a sele¢do da anterior
imagem tivéssemos marcado tolerancia mais alta, por exemplo 60, teria selecionado
toda a drea da foto que corresponde ao céu.

Portanto, para ajustar as partes da imagem que entrardo dentro da selegdo com a

varinha, devemos ajustar o valor tolerancia.

Entre as opcdes também ha outras importantes:
Antialiasing, permite que as bordas da sele¢ao
se suavizem, de modo que embora sejam curvas,

ndo se produza um pixelado.

Contiguo é para que a selecdao sé seja de
pixels contiguos. E 0 modo por padrdo e como
explicamos a ferramenta. Porém, se ndo o
marcamos, permite selecionar todos os pixels da
imagem que tiverem uma cor parecida, embora

ndo estejam contiguas ao lugar onde fizemos

s -
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clique inicialmente.

Mostrar todas as camadas tem uma utilidade interessante quando trabalhamos com
distintas camadas em Photoshop. Uma coisa importante: com a varinha madgica, no
principio, fazemos sele¢cdes sobre a camada em que estivermos trabalhando, sem
mostrar outras que possam estar abaixo ou acima. Se selecionarmos mostrar todas as

camadas, faremos com que a varinha se fixe em todas elas como se fosse uma sé.

% ~ |[0Q P E) | Tokranca: 40  [[]Suavzar [V]Contiguo [7] Muestrear todas fas capas
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Apresentacdo

Este mddulo pretende continuar e concluir o projeto elaborado nos médulos anteriores,
trabalhando fundamentalmente a paginacao final do trabalho e a sua preparacdo mas
também todos os aspetos transversais que fazem parte do processo da edicdo.

O docente devera acompanhar a aprendizagem, que devera partir sob forma de proposta
de trabalho a realizar. Este mdédulo podera estar articulado com um projeto da disciplina

de Design Gréfico.

Objetivos da aprendizagem

Dominar as ferramentas de edicdo de imagem;

Importar e exportar ficheiros de imagem vetorial e estatica, textos e diagramas;
Construir maquetas;

Desenvolver praticas corretas de arte finalizagao;

Otimizar fluxos de producdo, a semelhanca dos utilizados em meios profissionais;

Preparar materiais para impressao.

Ambito dos conteudos

Organizagao dos diferentes contetdos

Tratamento da informacdo: Textos, imagens, graficos, diagramas
Importacdo e exportacdo dos contetddos

Paginac¢ao dos conteudos

Maquetizacao

Provas e revisdo grafica

Preparagao para a impressao

h
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Conceitos Basicos de documentos e
Paginas Mestre

O InDesign é um potente software criado pela Adobe, os mesmos criadores do Photoshop,
Illustrator, Fireworks e varias outras aplicacdes criativas.

E um dos aplicativos padrdo da industria usados para criar (ou, mais provavelmente
«juntos») documentos impressos, como revistas e livros. Ele pode ser usado para a
producdo de produtos de impressao a partir do zero, mas é na verdade projetado para
importar os seus graficos ja criados a partir de outros softwares como Photoshop e
Illustrator, bem como documentos com varias paginas.

Ele também pode ser usado para criar uma pagina de documentos, tais como folhetos e
cartazes, no entanto, ele ndo é muito usado para este fim, como o Photoshop e lllustrator
sao capazes disso sem ter que exportar e importar os graficos.

O InDesign tem um concorrente conhecido, QuarkXPress, que também é uma aplicacao

padrdo da industria.

O que sdo Pdginas mestre?

Paginas mestras sdo usadas para exibir a mesma informacdo em cada pagina em todo o
documento - pode pensar neles como um modelo para paginas especificas. Por exemplo,
se queria um logoétipo da empresa a ser exibido no rodapé de cada uma de suas paginas,
pode aplicar uma pdgina mestra para cada um.

N3o esta restrito a apenas uma pagina principal, no entanto, pode configurar dois (e mais
do que isso), permitindo-lhe aplicar mestre paginas diferentes para paginas diferentes,
acelerar o seu andamento do trabalho, mas permitindo que tenha um pouco de variacao,
ao mesmo tempo. Por exemplo, num layout de revista, um designer de layout pode ter
uma pagina principal configurado para uma caracteristica particular que publicar em
cada edicdo da sua revista, permitindo-lhes facilmente importar texto e graficos em
espacos reservados ja criados.

E uma maneira simples e rapida para a producdo de design consistente, sem ter que

mexer muito com dimensdes e estagios.
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Pdginas Mestre e Guias

Uma guia é uma linha de pixels de largura que aparece no monitor, mas ndo sera
impresso quando o documento é enviado para a grafica, e ndo vai aparecer depois de
ter exportado o documento para PDF. As guias também podem ser escondidas, se ndo
quiser vé-las enquanto elas ndo sao usadas para o que esta a fazer atualmente.
Adicionar guias as suas paginas mestras é facil. Dé um duplo clique no seu “A-Master”
paginas, que se encontra na seccdo superior do painel de paginas. As duas paginas
mestras aparecerdo na janela do seu documento.

Existem varias maneiras de adicionar guias. Pode arrasta-las diretamente para fora dos
seus documentos, ou adiciond-las ao seu documento, precisamente por ir a Layout>
criar guias. Vamos fazer isso da maneira precisa, entdo va a Layout> Criar guias.

Nés vamos criar um guia de rede para as nossas paginas mestre. Verifique se a caixa de
selecdo prévia estd marcada - o que ird nos permitir ver onde os nossos guias estdo a ser
colocados. Certifique-se também que as guias de ajuste a caixa margens estd marcada -
o que ird atender as guias de maneira uniforme entre as guias, em vez de a pagina, que
€ 0 que nds queremos, ja que iremos ter certeza que todo o texto é colocado dentro de
nossas margens, em vez da nossa pagina.

Adicione 8 linhas com uma calha de 0 milimetros e duas colunas com uma calha de 3mm

e clique em OK.

114 | cURsO TECNICO DE ARTES GRAFICAS




Manual do Aluno

Com nossas pdginas mestre agora cheias de guias, vai notar que todas as nossas paginas
tém agora este guia configurar. Pode ver todas as paginas ao mesmo tempo, diminua o

zoom - pode fazer isso indo para Visualizar> Menos Zoom.

Pdginas Mestre e Texto

Agora que ja viu como é simples de usar o recurso de paginas mestre no InDesign, que
vai passar para a adicao de algum texto em paginas dos nossos mestres. Qualquer texto
(ou imagens) que coloca nas paginas mestras também vai aparecer no mesmo lugar em
todas as outras paginas que tém a pagina principal aplicada a eles - é ideal para coisas

como um rodapés, logétipos e cabecalhos.
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Dé um duplo clique em voltar para a sua pagina mestre A-Master. Zoom (Visualizar>
Ampliar) para as paginas mestras preencher a tela, ou va a Exibir> Espalhe Ajustar a
janela para fazer isso automaticamente. Selecione a ferramenta Type e arraste uma
caixa de selecdo no rodapé da sua pdgina principal esquerda, exatamente como faria em
gualquer outro documento ao usar qualquer outro aplicativo com a mesma ferramenta.
Preencha a sua caixa de texto com algum texto - eu vou usar “Fundamentos SpyreStudios

InDesign”.

SpyreStudios InDesign Basics

Com isso feito, deve ver agora este pedaco de texto em cada uma de suas pdginas da
mao esquerda - pode simplesmente copiar e colar na caixa de texto na sua pagina mao
direita, se quer que ele apareca I3, também, a menos que queira adicionar nimeros de

pagina. Nesse caso, leia o passo seguinte.

Pdginas Mestre e numeros de pdgina atuais

Provavelmente pergunta-se como adicionar nimeros de pagina a sua pdgina. Isto é
surpreendentemente facil. Ainda vendo o Master-A pégina principal, clique na sua caixa
de texto existente. Redimensiona-la de modo que é a largura das margens na sua pagina.
Clique duas vezes na caixa de texto para comecar a editar o texto e mova o cursor para o
inicio da sua caixa de texto antes que qualquer outro texto apareca.

Ir para Tipo> Inserir caractere especial> Marcadores> Numero da pagina atual. A letra
“A” ird aparecer. Esta carta representa o mestre A-Grade-Rodapé - basicamente o que
significa que sabe o que a pdgina atual em que est3, e vai realmente apresentar o nimero

da pdgina em suas pdaginas reais e ndo a sua pagina principal.
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Agora precisamos de duplicar o nosso nimero de pdgina da esquerda rodapé e texto
para a nossa pagina direita na pagina principal mestre-A. Fazer isso é muito simples.
Poderia, claro, apenas digitd-lo novamente, mas se quiser salvar um minuto ou dois,
pode simplesmente selecionar a ferramenta de sele¢dao e, embora mantendo a tecla Alt
no Windows, ou a tecla Option no Mac OS, clique na caixa de texto de rodapé e arraste-o
para a outra pagina, certificando-se que seja alinhado com as guias corretos.

Clique duas vezes na sua caixa de texto de novo e selecione todo o texto dentro dela
e alinhe-o para a direita. Excluir o Espaco Em, e depois cortar e colar o “A” para o lado
direito do seu texto e, em seguida, insira novamente o Espaco Em usando a mesma

técnica que usamos anteriormente.

A Eprelmdion InDenigs Banicy 1 Ennefoadion InDevipe Badcs A&

Agora deve ser capaz de visualizar qualquer uma das suas paginas, e ver que o nimero
de pagina correto estd a ser exibido! Isso funciona para qualquer documento tamanho

que tem - se é 5 pdginas, 50 paginas ou 500 paginas.

6 SpyreStudios InDesign Basics

Renomeando & Cria¢do de novas paginas mestras

Como mencionado anteriormente, o InDesign pode suportar mais de uma pdagina

principal, tornando-se possivel ter determinadas sec¢des usar uma pagina mestre, e
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ao resto do uso de documentos outra pagina mestre. Se vai fazer isso, renomear suas
paginas mestras é incrivelmente util para evitar o uso do errado. Demora apenas 10
segundos para renomear uma pdagina mestre.

Dé um duplo clique na sua pdgina mestre “Um Mestre” e selecione a lista suspensa no

painel de paginas (ver imagem abaixo). Selecione “Op¢bes de mestre para um Mestre”.

40 [50, [0 |70, [280 Tzqi Insert Pages...

“  New Master...
Rotate Spread View 3
Page Transitions >

Master Options for "A-Master”...

Load Master Pages...

Hide Master ltems
Override All Master Page Items Lol

i "

v Allow Document Pages to Shuffle

Um Mestre janela Opgdes ird aparecer, permitindo que modifique o seu prefixo (A), o seu
nome (Master), o mestre é baseado em (Nenhum) e quantas paginas a pagina principal

tem (2). Mudar o nome para “Guias de grade e numeros Rodapé”.
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Master Options.

Prefix: A ( Oi(:
Name: Guides & Footer Numbers 7 Cancel

- Based on Master: .[Nnne] e I

Number of Pages: 2

| I I

Vai ver agora que “um mestre” foi alterado para “A-Grid Guias & numero de rodapé”.
Para criar novas pdginas mestras, pode selecionar a op¢do novo mestre da mesma queda
para baixo lista que acabou de usar. Chame este mestre «Shape Cabegalho”. Ao basear
0 mestre noutro mestre (Guias ou seja, nossa grade & pdagina mestre rodapé Number)
serd, em principio, exatamente o mesmo.

Podemos adicionar novos elementos para esta pagina mestre, enquanto ainda mantém
os elementos do nosso mestre original. Isto é especialmente Util para este caso particular,
como ainda queremos os nossos numeros de pagina aparecam em todas as paginas que

a nossa nova pagina mestra é aplicada muito bem.

MNew Master
Prefix: B ok )
Name: Header Shape (  Cancel )
|

Based on Master: | A-Grid Guides &... %

- Number of Pages: 2 L

Clique duas vezes em seu novo mestre para vé-loem nossa janela do documento principal.
Deve olhar idéntica a nossa pagina mestre original. Todas as alteracdes que fazemos a

nossa pagina mestre original também sera exibido em nossa nova pagina principal.

Criando um simples elementos grdficos de cores e espagos
reservados titulo

Nés vamos criar um simples grafico de uma cor e um espaco reservado de texto para a
nossa nova pagina mestra, que ira funcionar como um cabecgalho para sec¢des especificas

do nosso documento.
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Primeiro, verifique se esta a ver a nossa nova pagina principal. Selecione a ferramenta
Retangulo e arraste uma selegdo sobre a nossa pagina dupla, como pode ser visto abaixo.
Encha-a com uma cor de sua escolha. Lembre-se, estamos apenas a aprender a usar os
recursos InDesigns aqui - portanto, ndo passar horas apenas fazendo as coisas parecem
boas! Certifique-se de a sua forma espalha direito até a borda do sangramento. Vai
notar que esta forma azul sé aparece na nossa nova pdgina principal, e ndo na nossa
original. Ela também ndo aparece em qualquer uma das nossas paginas, no entanto,

ainda ndo aplicou esta pagina mestra para qualquer um delas!

B SpveSiados InDevign Basdcy SacSiudion TaDeugn By 0

Em seguida, vamos adicionar um titulo (cabecalho) do espacgo reservado. Com a sua
nova pagina principal ainda selecionada, selecione a ferramenta de texto e arraste uma
caixa de texto sobre a sua nova forma azul - sé esticar a caixa de texto até a margem
direita na pagina esquerda. Tipo “Titulo Uma ...”, aumentar o tamanho do texto e mudar
a cor (se quiser também!). Repita 0 mesmo processo para o site da direita da nossa
pagina principal, mas desta vez com menos texto - talvez esta drea poderia ser alargada

para uma cotagao.
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Aplicando Pdginas Mestras para paginas de documentos

NOs agora vamos configurar as duas pdginas mestras - uma das quais ja foi

(automaticamente) aplicada a todas as nossas paginas. Agora, no entanto, precisamos

que tudo esteja arrumado. Para comecar, ndo queremos 0s N0ssos numeros de pagina

a serem exibidos na nossa capa e contracapa, uma vez que existem (obviamente) e ndo

cobrem as paginas. N6s também queremos aplicar a nossa pagina principal cabecalho

para alguns das nossas duplas-paginas.

Remover e aplicar paginas-mestre a paginas de documentos é muito simples. Tudo o

gue tem a fazer é arrastar e soltar. Na parte superior do painel de paginas, tera trés

paginas mestras: “Nenhum”, “A” e “B”.

Cliqueearraste “Nenhum” paraasuafrente etampatraseira. Vaiveragoraque asuapdgina

ndo contém nada, mas a sua primeira pagina ainda estd numerada “2”. Para mudar isso,

cliqgue com o botdo direito
na sua primeira pdgina (a
pagina lado esquerdo da
sua propagagao primeira
dupla) e selecione Opg¢des
de numeragdo e seccao.
A “Nova Secdo” janela
aparecera. Certifique-se de
“Start Page Numbering at:”

é selecionado, e mudar “1”

para “2”. Clique em OK.
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Arraste o “B” pagina mestre para qualquer uma das paginas que deseja ter um titulo
diante. Vou colocar em todas as pdaginas de propagac¢ao outra dupla, como pode ser visto

abaixo.
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Substituindo Objetos Master Page

No seu estado atual, ndo pode realmente aumentar o zoom para uma das nossas paginas
de documentos e editar o texto de espacgo reservado que aplicamos o nosso “B” da
pagina principal.

Isto porque todo o conteldo das nossas paginas mestre estd atualmente bloqueado
para evitarmos acidentalmente clicar em, redimensionar e mover o conteddo. Nés nao
queremos ser capazes de fazer isso como padrao, pois iria contra todo o objeto de ter
paginas mestras, que é para manter o nosso projeto consistente em todo o documento.
Substituindo os nossos itens de pdagina-mestre em pdaginas dos nossos documentos é
uma tarefa muito facil, porém, ndo se preocupe! Tal como acontece com a maioria das
coisas no InDesign, é facil.

O direito de zoom no seu primeiro titulo que deseja editar. Se tentar selecionar a sua
caixa de texto do espaco reservado contendo “uma posicdo ...” ele simplesmente ndo
vai reconhecer que ele esta l1a. H4 uma maneira simples de “desbloquear”, no entanto,
mantenha a tecla Shift + Ctrl (Windows) ou Shift + Command (Mac OS), e tente clicar na
caixa de texto do espaco reservado.

Agora deve ser capaz de edita-lo - colocar numa posicao que se adapte a esta pagina
particular. Fazendo isso ird desbloquear a caixa de texto para sempre, e ndo apenas de

forma temporaria - tenha a certeza que ndo quer mové-la.

Master Pages...

Pode usar exatamente a mesma técnica para selecionar a citagdo e a forma azul.
Selecione a forma azul, e vamos mudar a sua cor - de novo, isso ira desbloquear a forma

para sempre, e ndo apenas numa base temporaria.

124 | cURSO TECNICO DE ARTES GRAFICAS




Manual do Aluno

Master Pages...
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Adicionar, organizar e apagar paginas

Até agora deve apreender as ferramentas basicas, paginas e opc¢des de pagina-mestre no
InDesign, e provavelmente ja viu como adicionar, organizar e apagar paginas do InDesign
ja, se ndo por fim, por engano!

Adicionar novas paginas é um recurso muito Util. Nunca se sabe quando pode precisar
de uma pagina extra ou duas - talvez um cliente tenha encontrado um outro anunciante
no ultimo minuto ou outro artigo veio em cima do prazo? Sem esses recursos, seria uma
dor muito grande para voltar a fazer tudo!

No painel pdginas, ha um simbolo de nova pagina na parte inferior - similar ao utilizado
para nova camada em ambos Photoshop e lllustrator. Quando clicar neste, ele insere
uma pagina abaixo do que esta atualmente, e também aplica as paginas mestras a esta.
Queremos inserir um spread abaixo da sua nova dupla ultima pagina de titulo. Com a
ultima pagina titulo selecionado, cliqgue no icone de pagina nova. Uma nova pagina que
se parece exatamente igual com a de cima vai aparecer.

Nds ndo queremos isso para que a pdgina principal titulo aplicado, portanto, basta

arrastar “Nenhum” para a propagacdo nova pagina dupla, e em seguida, arraste o
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“A” pagina principal sobre a mesma. Isto vai dar a nova pagina o texto de rodapé e a

numeragao de paginas.

Eliminar paginas é tdo facil quanto selecionar a pdgina que deseja excluir e clique no
icone de exclusao chave diretamente ao lado do icone nova pdgina, e para reorganizar
certas paginas pode simplesmente clicar e arrastar uma pdgina no seu painel de paginas
para sua nova posi¢cdao. Como temos utilizado a pagina especial recurso de numeracao,

todos os numeros de pagina atualizar-se-do automaticamente.

Criar Frames texto com colunas

A criacdo de quadros de texto com colunas é outro recurso InDesign. Estamos a adicionar
este quadro de texto para o nosso “B” quadro de pdgina mestre para que ele seja aplicado
a todas as nossas pdginas com a pagina mestre particular aplicado - o que ird nos salvar
de fazer a mesma coisa varias vezes.

Dé um duplo clique na sua pégina principal “B”, e selecione o tipo de ferramenta. Arraste

uma nova caixa de texto, certificando-se que ela se encaixe para cada margem.
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Copie a caixa de texto que acabamos de criar, e cole-o no lado direito, certificando-se
que as linhas estdo contra as mesmas guias e margens. Como este é um layout de revista
/ livro, queremos que essas duas caixas de texto em link, para que os primeiros fluxos
um para o segundo. Nés também queremos que eles tenham duas colunas. Assim, no
total, havera quatro colunas ao longo de duas paginas, que fluem para a coluna seguinte.
Selecione a ferramenta de sele¢do e clique na sua primeira caixa de texto, e em seguida,
enquanto pressiona a tecla Shift, clique na sua segunda caixa de texto. Com as duas
selecionadas, selecione o tipo de ferramenta. No painel de controle acima da sua janela
do documento, clique na seta ao lado da caixa de colunas a aumentar para dois (ver

imagem abaixo).

e 8O + & F Fils:ls Q

GETTING STARTED v+ | | 2 ]
9], [ [Basic Paragraph] T}E =<2 4

EE E Hyphenate I+ | BE | Is;

2 PAGES | LINKS =
i
A-Grid Guides & Footer Number [I]

0 J280 1290 100 [0 {320 230 [0 oo e ]

CURSO TECNICO DE ARTES GRAFICAS | 127




EDICAO ELETRONICA

Agora precisamos de vincular as nossas duas caixas de texto com colunas em conjunto
para que flua num outro. Isso é muito facil de fazer, mas é muito dificil de explicar.
Selecione a ferramenta de selecdo e clique na sua primeira caixa de texto. Vai notar
que hd uma pequena praga em direcao ao canto inferior do lado direito - veja a imagem

abaixo.

| T SpyreStudios

Clique no pequeno quadrado. Um icone deve aparecer —deve-se olhar como varias linhas
de texto. Uma vez que apareceu, clique diretamente na sua segunda caixa de texto. O
icone que acabou de ver (do texto) deve ter-se transformado numa pequena cadeia. Se
ele tem caixas de texto estdo agora oficialmente ligadas! Se ndo, tente novamente - vai

descobrir isso eventualmente!

Importagéo de texto para o seu Documento

O InDesign ndo é um aplicativo de edicdo de texto, e ndo foi projetado para escrever o
seu texto diretamente para ele - embora seja perfeitamente capaz de fazé-lo, os editores
tendem a escrever a sua copia num aplicativo que é dedicado ao processamento de

texto, como o Microsoft Word ou OpenOffice Writer.

Se ainda ndo tem qualquer texto que deseja colocar no seu documento, crie rapidamente
um documento ficticio. Na verdade, estou a usar o arquivo original do que esta a ler
atualmente.

Va a File> Place, e selecione um. Doc. Quando abrir o seu documento de texto, vai ver
as primeiras linhas do mesmo. Basta clicar sobre a caixa de texto, e os documentos. O
conteludo doc sera colocado automaticamente na sua caixa de texto, e deve fluir através

de todas as quatro colunas como configurado na etapa anterior.

s -

R4t e
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Colocando o texto automaticamente, copiar os estilos que foram usados no documento.

III

Para alterd-lo de volta ao “normal” pode destacar todo o texto na caixa de texto e
simplesmente mudar a fonte e o tamanho do texto. Também pode jogar com o lider
de rastreamento para que ele comece a olhar como quer. Lembre-se, esta é apenas
um exercicio pratico. Nés vamos para as defini¢ées de tipografia num futuro tutorial “O

confronto com o InDesign”.
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Criacdo de Indice/Sumario

Um sumario pode registar o conteddo de um livro, revista ou outra publicacdo; exibir uma
lista de créditos de ilustragGes, anunciantes e fotografias; ou incluir outras informacoes
para ajudar os leitores a encontrar informag¢des num documento ou arquivo de livro. Um
documento pode ter varios sumarios (por exemplo, uma lista de capitulos e uma lista de
ilustracoes).

Cada sumadrio é uma matéria distinta com um titulo e uma lista de entradas classificadas
por numero de pdgina ou alfabeticamente. As entradas, incluindo nimeros de pagina,
sdo obtidas diretamente do conteldo do documento e podem ser sempre atualizadas,
mesmo entre varios documentos de um arquivo de livro.

O processo para criacao de um sumario requer trés etapas principais. Primeiro, crie e
aplique os estilos de paragrafo que usard como base para o sumario. Segundo, especifique
quais estilos sdo usados no sumdrio e como o sumario é formatado. Terceiro, copie o
sumario para o documento.

As entradas do sumario podem ser adicionadas automaticamente ao painel ‘Marcadores’

para uso em documentos exportados como Adobe PDF.

Dicas para criar um sumadrio

Ao planear um sumario, considere o seguinte:

Alguns sumadrios sdo criados a partir de conteddo que, na verdade, ndo é exibido no
documento publicado (como uma lista de anunciantes em uma revista). Para fazer isso
no InDesign, digite o conteido em uma camada oculta e inclua-o ao gerar o sumario.

E possivel carregar estilos de sumdrio de outros documentos ou livros para criar novos
sumarios com as mesmas configuracdes e formatacao. Talvez seja necessario editar um
estilo de sumario importado se os nomes de estilos de pardgrafo no documento nao
corresponderem aos do documento de origem.

E possivel criar estilos de pardgrafo para o titulo e entradas do sumario, incluindo
paradas e guias de tabulacdo. Poderd, entdo, aplicar esses estilos de paragrafo ao gerar

0 sumario.
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E possivel criar estilos de caracteres para formatar os nimeros de pagina e os caracteres
gue os separam das entradas. Por exemplo, se desejar que os numeros de pagina
aparecam em negrito, crie um estilo de caracteres que inclua o atributo negrito e

selecione esse estilo quando criar o sumario.

Criacdo de sumdrios em livros

Para obter melhores resultados, siga estas etapas antes de criar um sumario para um
livro:

Antes de criar um sumdrio, verifique se a lista do livro estd completa, se todos os
documentos estdo listados na ordem correta e se todos os titulos foram formatados
com os estilos de paragrafo adequados.

Use estilos de paragrafo uniformes em todo o livro. Evite criar documentos com estilos
gue tenham nomes idénticos e definicdes diferentes. Se varios estilos tiverem o mesmo
nome e defini¢cdes diferentes, o InDesign usara a defini¢do de estilo do documento atual
(caso haja alguma) ou a primeira ocorréncia do estilo no livro.

Se os estilos necessarios ndo aparecerem nos menus pop up da caixa de didlogo ‘Sumario’,
serd necessario sincronizar o livro para que os estilos sejam copiados para o documento
gue contém o sumario.

Se desejar exibir prefixos de numero (como 1-1, 1-3 etc.) no sumario, use a numeragao
de seccdo em vez da numeragdo de capitulo. E possivel incluir prefixos de nimero de

sec¢ao num sumario.

Gerar um sumadario

Antes de gerar um sumario, decida quais os paragrafos que serao incluidos (por exemplo,
titulos de capitulo e de sec¢do); em seguida, defina estilos de paragrafo para cada um
deles. Verifique se esses estilos sdo aplicados a todos os paragrafos apropriados do
documento ou dos documentos do livro.

Ao gerar o sumario, vocé também pode usar estilos de pardgrafo e caracteres para

formata-lo.
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Sumdrio sem estilos de pardgrafo (a esquerda) e com estilos de pardgrafo aplicados as

entradas (a direita)

Se os paragrafos que devem ser inclusos no sumario aparecerem em diferentes matérias
na mesma pagina, a sua ordem nesse sumario sera determinada pela posicdo que

ocupam na pagina.

Siga um destes procedimentos:

Se estiver a criar um sumadrio para um unico documento, podera incluir uma nova pagina
no inicio do documento.

Se estiver a criar um sumario para varios documentos de um livro, crie ou abra o
documento a ser usado para o sumario, verifique se ele foi incluido no livro e abra o

arquivo de livro.

Escolha ‘Layout’ > ‘Sumario’.

Se definiu um estilo de sumdrio que tem as configura¢des apropriadas para o seu
sumario, podera seleciona-lo no menu ‘Estilo de sumario’.

Na caixa ‘Titulo’, digite um titulo para o sumario (como Conteudo ou Lista de figuras).
Esse titulo sera exibido no inicio do sumario. Para formatar o titulo, escolha um estilo no
menu ‘Estilo’.

Selecione ‘Incluir documentos de livro’ para criar um Unico sumario para todos os

documentos existentes na lista do livro e para renumerar as paginas do livro. Desmarque
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essa opc¢ao se desejar gerar um sumario somente para o documento atual. Essa opc¢do
aparecera esbatida se o documento atual ndo fizer parte de um arquivo de livro.
Determine qual o contelddo que deseja incluir no sumario, clicando duas vezes nos estilos
de pardgrafo na lista ‘Outros estilos’ para adiciona-los a lista ‘Incluir estilos de paragrafo’.
Selecione ‘Substituir sumario existente’ para substituir todas as matérias de sumario
existentes no documento. Desmarque essa opg¢do se desejar gerar um novo sumario; por
exemplo, uma lista de figuras.

Especifique opc¢des para determinar como cada estilo de paragrafo no sumadrio sera
formatado. (Consulte Op¢des para formatar um sumario.)

E uma boa ideia definir um estilo de sumario que contenha a formatacdo e outras
opcOes, especialmente se quiser incluir varios sumarios no documento. Para fazer isso,
clique em ‘Salvar estilo’. Também é possivel criar estilos de sumario escolhendo Layout
> Estilos de sumario.

Clique em ‘OK’.

Sera exibido um cursor de texto carregado . Antes de clicar ou arrastar, pode ir para outra
pagina ou criar uma nova pagina sem perder o texto carregado.
Clique ou arraste o cursor de texto carregado numa pagina para inserir a nova matéria

de sumario.

Criar estilos de sumadrio para listas multiplas

Use estilos de sumario se tiver que criar sumarios diferentes no documento ou livro. Por
exemplo, é possivel usar um estilo de sumario para uma lista de conteudo e outro para
uma lista de créditos de anunciantes, ilustracdes ou fotos. Crie um estilo de sumario para
cada tipo de lista.

Criar estilos de sumdrio também é (til caso deseje usar a mesma formatagdo de sumario
noutro documento.

Nota: Nao confunda estilos de sumario com estilos de paragrafo com um prefixo “Analitico”.
Os estilos de pardgrafo com o prefixo Analitico (por exemplo, “titulo do sumario”) sdo

usados para formatar as entradas de sumario. Por outro lado, um estilo de sumario é um

conjunto de configura¢des usadas para criar automaticamente um sumario.
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Criar um estilo de sumario

Escolha ‘Layout’ > ‘Estilos de sumario’.

Clique em ‘Novo'.

Digite um nome para o estilo de sumario que esta a criar.

Na caixa ‘Titulo’, digite um titulo para o sumdrio (como Conteudo ou Lista de figuras).
Esse titulo serd exibido no inicio do sumdrio. Para especificar um estilo de titulo, escolha
o estilo no menu ‘Estilo’.

Na lista ‘Outros estilos’, selecione os estilos de paragrafo que representam o conteudo
a ser incluido no sumario; em seguida, clique em ‘Adicionar’ para adiciona-los a lista
‘Incluir estilos de paragrafo’.

Especifique opc¢des para determinar como cada estilo de paragrafo é formatado.

(Consulte Opgoes para formatar um sumario.)

Importar estilos de sumdrio de outro documento

Escolha ‘Layout’ > ‘Estilos de sumario’.
Cliqgue em ‘Carregar’, selecione o arquivo do InDesign que contém os estilos de sumario
gue deseja copiar e clique em ‘Abrir’.

Clique em ‘OK’.

Opc¢bes para formatar um sumario

Ao gerar ou editar um sumario, use estas opcdes para determinar a aparéncia do texto
do sumadrio gerado. Algumas dessas opc¢des sé permanecem disponiveis quando clica
em Mais Opc¢Oes na caixa de didlogo.

Nota: As configura¢des da seccdo ‘Estilo’ sdo aplicadas apenas ao estilo selecionado no
momento em ‘Incluir estilos de paragrafo’. E possivel especificar diferentes opcdes de

formatacdo para cada estilo.

‘Estilo da entrada’
Para cada estilo em ‘Incluir estilos de paragrafo’, escolha um estilo de pardgrafo para

aplicar as entradas de sumadrio associadas.
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‘Numero de pagina’

Podera criar um estilo de caracteres para formatar o nUmero de pdagina. Em seguida,
podera selecionar este estilo na lista pop up ‘Estilo’ a direita de ‘Numero de pagina’.
(Consulte Adicionar estilos de paragrafo e de caracteres.)

Se desejar incluir prefixos nos nimeros de pagina do sumario ou usar outra convencao

de numeracao, consulte Definir a numeracado de secgdes.

‘Entre a entrada e o nUmero’

Especifique os caracteres a serem exibidos entre a entrada de sumario e o nimero
de pagina correspondente. O padrdo é "t, que informa ao InDesign para inserir uma
tabulacdo. Pode escolher outros caracteres especiais, como ‘Tabulacdo de recuo a
direita’ ou ‘Espaco eme’, na lista pop-up. Para obter uma lista completa de caracteres
especiais e aprender a trabalhar com eles, consulte Inserir glifos e caracteres especiais.
Selecione o texto existente na caixa antes de escolher outro caractere especial, para ndo
incluir os dois caracteres simultaneamente.

Pode criar um estilo de caracteres para formatar o espago entre a entrada e o nimero de
pagina. Em seguida, selecione-o na lista pop-up ‘Estilo’, a direita de ‘Entre a entrada e o
numero’. (Consulte Adicionar estilos de paragrafo e de caracteres.)

Se o estilo de paragrafo da entrada incluir uma configuracao de tabulacdo, e os carac-
teres de guia de tabulacdo ("t) for selecionado, aparecera uma guia de tabulacdo no

sumario gerado. Para obter instrucdes, consulte Criar entradas de sumario com guias de

tabulacdo.
Estilg: Timulp 2

Fstiln da entrads’ Corpo da fexto do sumdnio E-l
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a . p- & ] 3
Vocé pode especificar um caractere para separar a L‘:‘:{]“‘ e e
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entrada do numero de pdgina, e também um estilo Chapter 3 31
. Reptiles 32
para Gp/lCGI’ a um desses caracteres. Lizanls 33
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Preparacao para impressao de
separacoes

Criacdo de separacoes

Parareproduzirimagens coloridas e de tonalidades continuas, as impressoras geralmente
separam a arte em quatro chapas — uma chapa para cada parte em ciano (C), magenta
(M), amarelo (Y) e preto (K) da imagem. Quando recebem a tinta da cor apropriada e
sdo impressas em registo umas com as outras, essas cores combinam-se para reproduzir
a arte original. O processo de dividir a imagem em duas ou mais cores é denominado
separacdo de cores, e os filmes dos quais as chapas sdo criadas sdo denominados

separagdes.

Composto (esquerda) e separagdes (direita)

Processos de producgdo de separagoes

O Adobe InDesign CS4 suporta dois processos de producdao comuns de PostScript. A
principal diferenga é onde as separagdes sao criadas: no computador host (o sistema que
usa o InDesign e o driver de impressora) ou no RIP (processador de imagens rasterizadas)

do dispositivo de saida. Outra alternativa é o processo de produgao de PDF.
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Separagbes baseadas no host

No processo de producdo tradicional pré-separado baseado no host, o InDesign cria
informacgGes PostScript para cada separacdo necessaria para o documento e as envia

para o dispositivo de saida.

Separacgdes In-Rip

No processo de producdo baseado em RIP mais recente, uma nova gera¢do de RIPs
PostScript executa separacdes de cores, trapping e até gestdo de cores no RIP, deixando o
host livre para executar outras tarefas. Essa abordagem faz com que o InDesign leve menos
tempo para gerar o arquivo e minimiza a quantidade de dados transmitidos para qualquer
tarefa de impressao. Por exemplo, em vez de enviar informacgées PostScript para quatro ou
mais pdginas a fim de imprimir separacdes de cores baseadas no host, o InDesign envia-as

para um Unico arquivo PostScript composto para processamento no RIP.

Preparar o documento para separagdoes de cores

1. Corrija quaisquer problemas de cores na arte.

2. Defina opg¢des de superimposicao.

3. Crie instrucGes de trapping para compensar erros de registo na impressora
tipografica.

4. Visualize as separacdes de cores na tela.

5. Nota: As etapas de 1 a 4 sdo recomendadas, mas ndo essenciais para produzir
separacoes de cores.

6. Escolha ‘Arquivo’ > ‘Imprimir’, para exibir a caixa de didlogo ‘Imprimir’.

7. Se tiver criado uma predefinicdo de impressora com as configuracdes de
separacdo apropriadas, selecione-a no menu ‘Predefinicdo de impressao’ na
parte superior da caixa de dialogo ‘Imprimir’.

8. Escolha uma impressora ou arquivo PostScript no menu ‘Impressora’.

9. Se estiver a imprimir num arquivo PostScript, escolha a PPD referente ao

dispositivo que imprimira as separacgdes.
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10. Para exibir ou alterar op¢des de impressao existentes, cliqgue num nome de
seccdo no lado esquerdo da caixa de didlogo ‘Imprimir’.

11. Antes de entregar o documento a um prestador de servicos, faca a prova das
separagdes.

12. Imprima ou salve as separacgdes.

Saida de cores especiais

E possivel usar tintas personalizadas, denominadas cores especiais, juntamente com as
cores de escala ou no lugar delas. Por exemplo, em vez de usar as quatro cores de escala
para reproduzir a arte com texto em preto e desenhos com linhas verdes azuladas, pode
usar duas cores especiais — uma cor para o preto e outra representando o tom exato do
verde. Pode usar tintas de cores especiais para criar cores que ndo sejam reproduziveis
por tintas CMYK, como cores fluorescentes e metalicas. Pode também misturar cores
especiais, ou cores especiais com cores de escala para criar tintas mistas.

E possivel colorir uma arte com cores de escala, cores especiais ou uma combinacdo de
ambas. Ao imprimir separagdes, pode converter cores especiais nos seus equivalentes

de cor de escala para que sejam impressas nas chapas CMYK.

Impresséo de um composto

Pode imprimir uma prova composta em cores ou escala de cinza para ver as cores do
documento. Uma imagem composta pode ajuda-lo a criar e fazer a prova do seu layout
antes de imprimir separagoes finais (que sdo caras).

Quando o InDesign imprime um composto, ele imprime todas as cores utilizadas no

arquivo numa Unica chapa, ndo importa se foram selecionadas algumas cores individuais.

Considere os seguintes problemas ao imprimir compostos:

Embora nenhuma prova fornega a representacdo exata da saida final, pode aumentar
bastante a precisdo por meio da calibragem de todos os dispositivos usados na criacdo de
um documento (como scanners, monitores e impressoras). Se os dispositivos estiverem

calibrados, o sistema de gestdo de cores podera ajuda-lo a obter cores previsiveis e uniformes.
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As opcoes de superimposi¢do selecionadas no documento serdo impressas corretamente
numa impressora que suporte a superimposicdo. Como a maioria das impressoras de
mesa ndo suporta a superimposicdo, pode simular os seus efeitos selecionando ‘Simular
superimposicao’ na secgao «Saida> da caixa de didalogo <Imprimir>.

Importante: A selecdo de ‘Simular superimposicdo’ convertera cores especiais em cores
de escala para impressao. Se desejar usar um arquivo para separa¢des num RIP ou para
saida final, ndo selecione esta opgao.

Ao imprimir numa impressora em preto-e-branco, o InDesign produzird uma versao
composta de escala de cinza nas paginas. Se o documento contiver cores, o InDesign
imprimira cinzas visualmente corrigidos para simular essas cores. Por exemplo, o cinza
gue simula uma tonalidade de amarelo a 20% é mais claro do que uma tonalidade de
20% de preto, pois 0 amarelo é mais claro que o preto.

Ao imprimir um livro com capitulos contendo estilos de trapping ou tintas especiais em
conflito, é possivel instruir o InDesign a sincronizar as configuragdes com o documento-
mestre.

Se estiver a usar a gestdo de cores com o recurso Livro, verifique se cada documento no
livro usa as mesmas configuracdes da gestdo de cores na caixa de didlogo Configuracoes

de Cor.
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